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Abstract 

 

The urban forest is an integral part and significant contributor to urban landscapes.  

Approximately 80% of the US population interacts with urban forests on a daily basis.  

The ecologic, sociologic, and economic benefits provided by urban trees have been 

shown to be worth billions of dollars.  Urban forestry has been recognized within the 

scientific literature for over 30 years.  As public education pertaining to the urban forest 

continues, it has become clear that a lack of a standardized definition complicates 

transmission of the message.  This study used a content analysis of 77 scientific and 

reference articles to determine the primary constituents comprising definitions of the 

urban forest and urban forestry.  We discovered that urban forestry definitions created 

since the first by Jorgensen are either similar or partial representations of his.  Likewise, 

definitions of the urban forest created since Moeller have neither added to his or were 

partial representations.  This study also developed spatial definitions of the urban forest.  

A programmatic spatial definition to delineate the areas considered urban by the 

Wisconsin DNR Urban and Community forestry program was developed and compared 

to areas spatially represented by urban areas in the 2000 census using ESRI Arc 9.1 

software.  It was determined that the most representative spatial extent at this time 

comprised both the 2000 census urban areas and all cities and all villages within 

Wisconsin.  With the standard urban forest definition and programmatic spatial 

representation, this study makes contributions to both the theoretical and application 

components of urban forest research. 
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CHAPTER 1 

LITERATURE REVIEW 

 
Introduction 
 

Urban forests are an important and integral, yet often overlooked, portion of urban 

environments (Dwyer and Childs 2004, McPherson 2004).  Understanding what we have 

for an urban forest resource facilitates achieving what we want to achieve from 

management of the urban forest (Miller 1997).  Assessment of the urban forest at local, 

state, and national levels is an important and needed mechanism to measure if the urban 

forest at each level is moving in a direction that is consistent with desired management 

objectives.  Urban forests can make a considerable difference in the quality of life by 

directly influencing the daily lives of approximately 80% of the United States population 

(Nowak et al. 2001, Dwyer et al. 2003).  Nearly 25% of the United States land area is 

either located in or functionally tied to urban areas and the greater metropolitan area 

(Nowak et al. 2001). 

 

Historically urban forests and tree planting efforts were viewed as city beautification 

projects (Miller 1997).  The majority of people believe their communities are better 

places to live because of public trees (Elmendorf et al. 2003, Schroeder et al. 2003, Lohr 

et al. 2004, Treiman and Gartner 2005).  A sole focus on the amenity value of the urban 

forests, however, can lead to overlooked or under-appreciated ecological and economic 

roles of urban vegetation, especially during periods of fiscal constraint.  Further, the 
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concept of the urban forest and its benefits do not appear to be well understood or 

recognized by the public (Hull 1992). 

 

Urban and metropolitan areas that include substantial forest resources have the potential 

to significantly improve the environmental quality of the urban environment and the 

well-being of its residents (Dwyer et al. 2003).  The urban forest contributes to the 

removal of air pollution, sequestration of atmospheric carbon dioxide, hydrologic 

benefits, energy conservation, and improves aesthetics (McPherson et al. 1994, 

McPherson 2004).   

 

Trees remove gaseous pollutants (e.g., ozone, nitrogen dioxide, sulfur dioxide, and 

carbon monoxide) by absorbing them with other normal air components (e.g., carbon 

dioxide and oxygen) through the stomates (McPherson et al. 1997, Harris et al. 1999).  

Beckett et al. (2000) found that roadside trees also capture 60% more large-size (>10 

microns) particulate matter than trees away from the road.  These findings have 

significant implications for air quality standards.  It has been estimated that the 

Wisconsin urban forest removes approximately 6,750 metric tons of air pollution per 

year, which has an associated societal value of $38.3 million per year (Nowak et al. 

2005).   

 

Trees also sequester carbon dioxide from the atmosphere during photosynthesis to form 

carbohydrates that are used in plant structure/function and return oxygen back to the 

atmosphere as a byproduct.  Approximately 800 million tons of carbon is stored in 
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United States urban forests with a $22 billion equivalent in control costs (Nowak et al. 

2005).  Wisconsin urban trees store an estimated 5.5 million metric tons of carbon 

(Nowak et al. 2005).  Furthermore, urban trees reduce surface runoff of water from 

storms (Xiao and McPherson 2002, McPherson 2004).  Resultant from the urban forest is 

reduced soil erosion, reduced sedimentation of streams, increased groundwater recharge, 

and lower amounts of chemicals transported to streams. 

 

Vegetative canopies in urban areas provide a cooling effect on microclimates directly by 

shading the ground surface and indirectly through transpiration (Scott et al. 1999).  

Because they lower air temperatures, shade buildings in the summer, and block winter 

winds, trees also reduce energy use associated with heating/cooling (Miller 1997, 

McPherson 2004).  The estimated annual energy use savings from well-positioned trees 

around a conventional house ranges between 20-25% (McPherson 2004, Nowak et al. 

2005).  In Wisconsin, it has been estimated that shading of buildings by trees save 

residents $9.6 million annually in heating and cooling costs. 

 

Aesthetically, well positioned urban trees and landscaping can increase property values 

up to 25-30%, improving resale values and increasing the tax base (Miller 1997).  This 

aesthetic value also translates into human health values.  Urban trees benefit mental 

health by creating feelings of relaxation and well-being (Kuo 2003).  They can also 

provide privacy in the form of a natural fence and a sense of solitude and security (Kuo 

2003).  Ulrich (1984) observed shortened post-operative hospital stays when patients 
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were placed in rooms with a view of trees and open spaces.  At a larger scale, urban 

greening projects can also help to build stronger neighborhoods and improve community 

involvement (Westphal 2003).  Finally, urban forests and parks provide an opportunity to 

improve physical health as they have become increasingly popular places to walk, run, 

and bike (Kuo 2003, Hansen-Moller and Oustrup 2004, Konijnendijk et al. 2004). 

 

Urban forests are necessary green infrastructure and a cost efficient way to effectively 

address urban ecosystem issues. Economic valuation methods have been developed to 

quantify these benefits (McPherson 2004).  For example, McPherson et al. (1994) 

calculated a benefit-cost ratio of 2.83 for urban trees in Chicago planted within yard, 

street, park, highway, and public housing settings.  This indicates that the value of 

projected benefits is nearly three times the value of projected costs over the 40 year 

planning horizon, using a 7% discount rate.  The Urban Forest Effects (UFORE) model 

uses urban forest structure based on field sampling of tree parameters to generate an 

estimated value of selected urban forest functions (e.g. carbon sequestration, air pollution 

removal) (Dwyer et al. 2000, Nowak and Crane 2000).  These estimated functional 

benefits can then be used as a means to quantify the economic contribution of urban 

forests within built environments and urban ecosystems. 

 

Another urban tree valuation model is the compensatory geared Council of Tree and 

Landscape Appraisers (CTLA 1992).  The CTLA approach uses a base value of the tree 

derived from size and species.  Multipliers for condition and location are then used to 

arrive at a final value.  The urban forest nationwide has a compensatory value of more 
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than $2 trillion (Nowak et al. 2002).  The significant benefits of the urban forest 

necessitate accurate methods to quantify the extent and composition of urban trees. 

 

Urban and Community Forestry 

 

Uncertainty exists with the use of terms community forest, urban forest, or urban and 

community forestry.  Urban and community forestry was used as early as November 

1967 in the report A Proposed Program for Urban and Community Forestry developed 

through a federal interdepartmental task force led by the U. S. Department of Agriculture 

– Forest Service (USDA-FS) (Unsoeld 1978).  Jorgensen (1970) first used the term urban 

forestry in 1965 at the University of Toronto.  Within Europe, recognition and 

application of the urban forestry concept came later than in North America (Konijnendijk 

2003).  However, a strong growing tradition of urban greening activities on private lands 

occurred in Europe over several millennia and neoclassical origins of trees incorporated 

into urban and town design and community forests occurred at least since the 16th century 

(Zube 1973, Lawrence 1988, Lawrence 1993). 

 

Community forestry, in contrast to urban forestry, has a much longer history.  Prior to 

European influence, native North Americans practiced extensive natural resource 

management including forests near settlements that are consistent with the modern 

concept of community forestry (Baker and Kusel 2003).  Originating in the Middle ages 

within Europe, the first record of community forestry in North America dates to 1710 in 

Newington, MA (Brown 1938, Holscher 1973, Barret and Baumann 1994, Konijnendijk 
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2003).  Community forests are public forests near a town, community, or municipality 

and managed for similar benefits that urban forests are detailed to provide today.  A 

distinct difference is a strong emphasis on managing for forest products (e.g., timber, 

fodder, and extractives) in community forests.  Community forestry has also been used to 

describe the participatory process of rural people in the use of public owned forests to 

provide the basic needs (i.e. food, shelter, etc.) of people, especially in third-world rural 

development (Pardo 1995).  Community forests occur on public lands, therefore, they are 

held in common and should be managed in the public’s best interest, which mandates 

public participation in the planning process (Baker and Kusel 2003). 

 

Urban and community forestry is often used interchangeably with urban forestry.  The 

community component suggests two things: (1) a population basis with community being 

less populated than urban areas and/or (2) it is a reflection of people being involved with 

decision making through participatory processes.  Even though many state and federal 

forestry agencies combine both terms, Moll (1995) suggested using urban forestry as it 

was short and to the point.  In contrast, Elmendorf and Luloff (2001) used community 

forestry solely to place an emphasis on the inclusion of people in the decision making 

process. 

 

The importance of the urban forest resource to people and the end use varies along a 

geographic continuum.  Since many urban residents use greenspaces near their residence 

for recreation, relaxation, and conveying with nature, local forested areas are very 

important for people (Dwyer and Barro 2001, Vogt and Marans 2001).  Public urban 
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greenspaces also have a positive effect on property values (Crompton 2001).  People can 

also find similar uses and benefits in rural forested areas, yet time and cost involved with 

travel lessens the immediate importance to residents of urban areas.  

 

Defining the Urban Forest 

  

The terms ‘urban forest’ or ‘urban forestry’ have become commonplace within scientific 

literature.  The history of arboriculture and urban forestry has roots tracing back 

thousands of years (Campana 1999, Miller 1997).  In the 1970’s urban forestry evolved 

into a separately recognized entity of forestry, and many proposed definitions have 

followed (Hauer 2005).  There has yet to be, however, a single definition accepted by 

professionals within their field (Konijnendijk et al. 2006).  Many researchers have posed 

their own definitions by describing the important aspects of the urban forest (Hauer 

2005).  These definitions have borrowed from previous research and presumably 

developed over time as urban forests and urban forestry have gained acceptance.  A 

review of these shows the most common aspects or categories mentioned in relation to 

urban forests and urban forestry are people (those influenced by the urban forest), 

geography (where the urban forest is located), benefits (qualitative and quantitative 

benefits provided by urban forests), resource (trees and other plants), activity (planning 

and management of the urban forest), and science (professional, specialized, skill, 

discipline). 
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Jorgensen (1970) provided the first robust definition of the urban forest and it included 

the six aforementioned integral components.  The six categories can be further distilled 

into constituent parts.  For example, benefits may be more fully described through 

attributes such as physiological, sociological, economic benefits associated with the 

urban forest.  An agreed upon definition of the urban forest would be beneficial to the 

professionals for future research, professional directions, and contribute to a better public 

understanding of urban forestry (Rowntree 1988).   

 

Previous Urban Forest Assessment 

 

Urban forests are ecosystems characterized by the presence of trees and other vegetation 

in association with people and their developments (Miller 1997, Dwyer et al. 2000).  

Municipalities regularly conduct city tree inventories, but they traditionally only account 

for public street and park trees, and rarely assess the urban forest growing on private land 

(Nowak et al. 1996, Dwyer et al. 2000).  As an example, approximately 90% of trees in 

the Chicago, IL area are located on private property, with approximately 75% of the 

urban forest canopy associated with these trees (McPherson et al. 1994).  Trees in 

suburban, rural-residential, and rural-agricultural areas that occur outside city limits are 

routinely not captured in urban forest assessments (Reimann 2003). 

 

Urban ecosystems represent a complex mosaic of vegetative land cover and multiple land 

uses (Foresman et al. 1997).  Though related, there is a clear distinction between land 

cover and land use.  While land cover refers to the biophysical earth surface, land use is 
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shaped by human, socio-economic and political influences on the land (Geist and Lambin 

2002).  Land use links land cover to the human activities that transform the landscape 

(NRC 1999).  The unique combination of buildings, impermeable cover (e.g. asphalt, 

concrete, etc.) and vegetation complicate classification methods and hinder assessment of 

the urban forest.  Furthermore, the gradients in ecological, sociological, and land uses 

that exist along urban to rural transects and complicate attempts to define the extent of 

the urban forest (Pickett et al. 1997).  Valid and replicable estimations of the urban forest 

resource therefore requires a robust sampling approach and a well defined spatial 

definition as to the extent of the urban forest.    

 

Approaches for Assessing Urban Forests 

 

Traditional forestry is management that is applied to rural forest settings (Helms 1998).  

These forests are managed to provide forest products, recreation, environmental services, 

tourism, and other societal desires that are reflected in management techniques.  Urban 

forests also provide, or have the potential to provide, outputs similar to rural forests.  

Since trees serve a vital function regardless of location, understanding this recourse is 

vital to incorporating urban vegetation into land use planning.  However, an ecological 

understanding of urban ecosystems must also include less densely populated areas 

because of reciprocal flows and influences between densely and sparsely populated areas 

(Pickett et al. 2001). 
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Urban forest structure is a three-dimensional spatial arrangement of vegetation in urban 

areas and includes parameters such as species composition, tree size and health, number 

and location of trees (McPherson 2004).  Quantifying this structure provides the basis for 

understanding the urban forest functions that affect urban inhabitants and improving 

management practices aimed at maximizing the environmental and social benefits 

derived from urban forests (McPherson et al. 1994, Dwyer et al. 2000).  Data such as tree 

species, diameter breast height (DBH), health, structural integrity, and site factors such as 

location, soil condition and competition describe the potential productivity, from which 

value of an urban tree population may be estimated.   

 

Various approaches have been used to measure urban tree cover, structure, and species 

composition (Nowak et al. 1996).  Complete tree inventories are one possibility, but they 

require considerable time and money to conduct.  They are suitable for small tree 

populations (e.g., one to two thousand trees) or when information on individual trees is 

required (Rideout 2006).  Another approach is to sample representative portions of the 

urban forest.  Sampling estimates tree populations and may be appropriate for large tree 

populations, especially when individual tree attributes are not required.  Sampling is also 

an efficient approach to assess the urban forest when the land base is too large or when 

financial resources are limited.  One sampling approach uses plots of a fixed size to 

establish a representative estimate of urban forest attributes (McPherson et al. 1994, 

Nowak and Crane 2000).  Another approach uses aerial photographs to provide highly 

detailed and cost-effective means of measuring urban tree and other surface cover 

(Nowak et al. 1996).  Analysis of canopy cover coupled with an on-the-ground 
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examination of the composition of tree species provides the basis to estimate the urban 

forest value to the urban ecosystem. 

 

Remote Sensing Assessment 

 

On a statewide or national scale, remote sensing technology can be used to coarsely 

survey the urban forest resource.  Sensors such as the Landsat-5 Thematic Mapper (TM) 

can record reflectance from 30 meter ground cells in 7 wavebands of the spectrum 

(Bolstad 2005).  Moderate resolution TM and Systeme Pour l’Observation de la Terre 

(SPOT) imagery have been widely used to understand the characteristics of urban 

surfaces (Harris and Ventura 1995, Gluch 2002, Zhang et al. 2002).  Images such as 

Advanced Very High Resolution Radiometer (AVHRR) data, TM, or SPOT provide 

information of very limited use at the scale of an individual neighborhood or city because 

of pixel size (Myeong et al. 2001).  The inherent limitations of remote sensing due to 

spatial resolution can be addressed primarily through field verification, but doing so 

requires additional time and effort.   

 

FIA Assessment 

 

The FIA system uses permanent plots systematically located across the United States and 

periodic inventories to assess changes in the Nation’s forest resource in rural areas.  

Developed by the USDA Forest Service this sampling procedure also has potential 

application in urban areas.  The urban forest is summarized from general data collected 
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on all plots and detailed tree data collected on forested plots (Reimann 2003).  Forested 

plots have been defined by the FIA as areas of at least 1 acre (.004046 km2) in size, at 

least 120 feet (36.576 m) wide, at least 10 percent stocked with trees, and have an 

understory that is undisturbed by another land use.  Under this system of classification a 

non-forest designation does not necessarily mean that a plot is devoid of trees.  This 

results in a data gap as it relates to the urban forest.  Plots that may be omitted include 

forested backyards, small woodlots in the middle of developments, road and highway 

medians and right-of-ways, or riparian buffer strips.  These plots represent a portion of 

the tree resource for which information on species, health, and biomass is not currently 

collected (Reimann 2003). 

 

Even though the FIA does not claim that its data capture more than forested areas, this 

information is sometimes used to describe all of the trees in a state because it is the only 

inventory that exists over large areas.  This becomes a functional problem for urban 

forest managers because the data does not necessarily reflect the resource they manage.  

The introduction and spread of exotic pests such as Asian longhorned beetle 

(Anoplophora glabripennis) and emerald ash borer (Agrilus planipennis) necessitates 

accurate estimates of tree populations across the entire landscape because the potential 

impact may be seriously under-estimated.  Reliable assessments of urban forest resources 

enable communities to project the potential impact of destructive pests.  Current 

estimates of the maximum potential national urban impact of infestations by A. 

glabripennis are $669 billion (Nowak et al. 2002). 
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Several preliminary studies have been conducted to collect tree data on plots defined by 

FIA as non-forest in urban areas to address the void in data for the urban forest resource.  

In areas that were determined to be nonforest by FIA definition, a 0.10 acre nonforest 

plot (37.24-foot radius circle) was established (Reimann 2003).  The decreased sample 

plot size was a compromise between being small enough to avoid multiple ownerships 

and large enough to capture sufficient tree data.  A pilot study conducted within a five 

county study area in Maryland used the .10 acre nonforest sample plot design (Reimann 

2003).  The results were positive and added considerably to the knowledge of the forest 

resource in Maryland.  Results have been mixed in other locations, including Wisconsin, 

due to an insufficient number of FIA sample plots (Nowak et al. 2005).   

 

State and Local Assessment 

 

On a local scale, tree inventories within cities or even counties typically have been 

conducted for public trees.  The vegetation included within these surveys is found in 

public right-of-ways or in park land and likely underrepresents the total urban forest.  As 

an example, street trees in Chicago were found to constitute 1 of every 10 trees overall 

and 1 of every 4 trees in single family to multi-family residential areas (McPherson et al. 

1994).  The remaining trees on private property are often overlooked because of 

accessibility and the difficulty of inventorying.  An assessment methodology is needed to 

incorporate both public and private trees in an urban forest inventory.  Some 

communities have used remote sensing to conduct a canopy analysis using CITYgreen 

software.  While fully inclusive, remotely sensed canopy analyses do not provide data for 
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identifying tree species or condition.  Furthermore, the sampling needs to be 

representative of the statewide urban forest rather than just a city or county for statewide 

urban forest planning.  The findings from the 2004 Governor’s Council on Forestry in 

Wisconsin listed developing statewide urban forest assessment as the first of three 

priority areas out of 50 identified actions (Wisconsin Council on Forestry 2004).   

 

Before a statewide inventory can be started, it must first be decided where to sample.  

Using the FIA definition of “non-forest” the unsampled areas from the national forest 

inventory can be mapped.  This is a potentially large void as any area not classified as 

rural forest would be included within this classification.  The fundamental problem with 

FIA at the statewide level is that using only a non-forest land designation is not 

appropriate because there are non-forest land uses (i.e. agriculture) that are still not urban 

in nature.  For example, row crop agriculture would be classified as “non-forest” using 

the FIA forest definition, but that type of land use should not be considered an “urban” 

area.  Another method of deciding where to sample from involves using the census 

definition based on population.  The US Bureau of the Census defines urban areas as 

incorporated or unincorporated areas with at least 2,500 people or density of at least 384 

people/km2 (1,000 people/mi2) (Dwyer et al. 2000).  These areas are easily defined and 

follow identifiable political boundaries, but this strict interpretation may result in 

excluding viable urban forest areas outside the identified political boundaries.  Similarly 

there may be forested lands within a political boundary that ought to not be classified as 

urban forest (i.e. school forests, county forests).  
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A programmatic definition of political entities or communities (i.e., cities, towns, 

villages) is another way to define the urban forest. The Wisconsin DNR Urban and 

Community Forestry program defines communities that fall within their programmatic 

guidelines for providing technical and financial assistance.  Their definition generally 

expands upon census defined areas by including areas that generally do not fit within the 

population parameters of the census-based definition of urban and metropolitan areas, but 

still exhibit urban characteristics through built environments.  Regional DNR Urban and 

Community Forestry coordinators work with communities to help develop and 

implement these forestry programs. 

 

Project Objectives 

 

This project is the first step in an ongoing state-wide urban forest assessment being 

conducted by the Wisconsin DNR and the University of Wisconsin – Stevens Point.  

Prior to conducting an urban forest assessment, we must first define the urban forest and 

identify the sampling area within Wisconsin.  The objectives of this study were to: 1) 

Develop a working ‘urban forest’ definition from the published literature, 2) define the 

spatial extent of the urban forest in Wisconsin using 4 approaches (2000 Census, DNRcvt, 

DNRcv, FIA), and 3) incorporate each definition into an ArcGIS 9.1 data layer to conduct 

spatial comparisons and facilitate future urban forest assessment work.  Further, 

comparison of different sampling approaches will facilitate cross comparisons and 

applications of the Wisconsin urban forest for local, state, and federal needs while 

improving upon sampling procedure. 
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CHAPTER 2 

PROJECT SCOPE AND METHODS 

 

Expanding urban centers have increased the public visibility and role of urban vegetation.  

As with any resource, effective management begins with developing an understanding of 

the breadth of the resource and the development of management goals based on this 

understanding.  Proposal of a universal working definition for the urban forest and a 

preliminary method for delimiting its bounds initiated urban forest assessment within 

Wisconsin.   

 

Comparison of Urban Forest and Urban Forestry Definitions 

 

Urban forestry is a relatively new addition to the field of forestry.  There was no 

definition for urban forestry until 1970 or the urban forest until 1977 (Weck 1966, 

Jorgensen 1970, Moeller 1977).  Since 1970 many definitions of the urban forest and 

urban forestry have been developed.  An understanding of how these definitions relate is 

unknown. 

 

A content analysis of urban forestry definitions over the last 40 years was used to 

describe the definitions.  We identified commonalities and differences/omissions to 

formulate the basis for unified urban forest and urban forestry definitions.  The 

definitions were found through searching professional journals where urban forestry 

related literature is published, review of urban forestry conference proceedings, and use 
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of the University of Minnesota Urban Forestry Database 

(http://forestry.lib.umn.edu/bib/urban.phtml).  There were six primary descriptive 

parameters associated with the definition urban forest or urban forestry; people, 

geography, benefits, resource, activity, and science (Table 2.1).  The six categories were 

selected based on the initial definition by Jorgensen (1970).  Attributes that correspond to 

the six categories were used to represent the presence or absence within a parameter.  

The initial selection of attributes was iteratively added to as additional definitions were 

analyzed.  Thus, the definition by Jorgensen was used as a standard to compare all later 

definitions against.  Later definitions were evaluated for additional categories that 

occurred as a result of the evolution of the urban forestry discipline or changes reflecting 

regional concerns/attitudes. 

 

If any attribute described a parameter in a given definition, a tally was recorded within a 

matrix containing all definitions, category, and attribute combinations.  A percentage of 

definitions containing references to the categories and attributes was then generated.  

Some terms or attributes were understood to represent multiple categories within the 

definitions.  For example, the attribute ‘urban’ was used in both the people and 

geography categories because describing an area as ‘urban’ implies people inhabiting a 

geographic place.  Three subcategories (ecological, sociological, and economic) were 

also created within the benefits category.  In order to receive a tally in the ecological, 

sociological, or economic subcategories; those benefits had to be explicitly stated.  The 

analysis was used to identify the terms most commonly associated with defining the 

urban forest.     
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Table 2.1. Six categories and attributes within a category used to describe urban forest 
and urban forestry definitions. 
 
A) People Based 

Urban 
Community 
City 
Village 
Town 
Suburb 
Local Government 
Population 
Concentration/Density 
Civilization 
People 
Man 

B) Geographically 
Located 

Urban 
Urbanizing 
Peri-urban 
Suburban/Fringe 
Adjacent Land 
Rural 
All 
City 
Town 
Village 
Public 
Private 
Community 
Greenspace 
Park/Street 
County 
Municipality 
Metropolitan 
Man's Environment 
Social/Urban Interface 
Reclaimed 
All Lands 
Area We Live 
Urban Woodland 
Watershed 
Populated Place 
Population 
Concentration/Density 

C) Benefit Producing 
 
1) 
Ecologic/environment 

Wildlife 
CO2 Sequestration 
Shade 
Windbreak 
Air Filter 
Noise Reduction 
Soil 
Glare 
Municipal Watershed 

 
2) Sociological 

Recreation 
Cultural 
Community 
Health 
Physiological 
Sensory 
Landscape 
Ornament 
Engineering 
Architectural 
Psychological 

 
3) Economic 

Recycling 
Ameliorating 
Aesthetic 
Amenity 
Windbreak 
Energy 
Real estate 
Food 
Wood Products 

D) Resource Containing 
Forest 
Tree 
Shrub 
Lawn/Turf 
Water 
Soil 
Wildlife 
Urban Plants/Woody 

Veg 
 
E) Activity Occurring 

Planning 
Management 
Cultivation 
Protection/Conservation
Maintenance/Care 
Design 
Improvement 
Establishment 
Anything 
Utilization 
Wise Use 

 
F) Science Surrounding 

Professional 
Specialized 
Art 
Discipline/Practice 
Systematic 
Science 
Technology 
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GIS Integration, Layer Creation, and Comparison   

 

To conduct an urban forest assessment in Wisconsin requires a spatial definition that 

delimits the potential geographical extent of the resource.  Since no accepted standard 

exists nationally or within Wisconsin, analysis of the Wisconsin urban areas began with 

the 2000 census, FIA, and two separate DNR definitions.  GIS layers representing the 

spatial extent of each category were established and served as the basis for comparison.  

All area measurements were rounded to the nearest hectare (2.47 acres).Land areas 

within and near populated areas in Wisconsin were defined using four classifications; 

2000 US Census, Wisconsin DNRcvt (including cities, villages, and towns), Wisconsin 

DNRcv (including just cities and villages), and FIA definitions.   

 

The 2000 US Census data and classification served as the starting point for area analysis.  

Discrete political boundaries were spatially defined and this presumably incorporated the 

majority of large urban areas across the state.  Census population centers are represented 

as ‘urban areas’ or ‘urban clusters.’  Census data was downloaded from 

(http://www.esri.com/data/download/census2000_tigerline/index.html), and the data 

from each county was merged to create a statewide urban area.  The 2000 US Census 

Bureau (2000) urban definition designated all territory, population and housing units 

located within an urbanized area (UA) or an urban cluster (UC).  It delineated UA and 

UC boundaries to include territories consisting of core census block groups or blocks that 

have a population density of at least 390 people/km2 (1,000 people/mi2) and surrounding 

census blocks that have an overall density of at least 195 people/km2 (500 people/mi2).  
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The problem with strictly using census data is that since it is population based, there are 

cities, villages, and towns left out because they do not meet population requirements, but 

do contain community tree populations with associated benefits.  The Wisconsin DNR 

provides financial and technical assistance to some of these communities that do not meet 

the population requirement as defined by the census parameters.  From a funding 

prospective, consideration is also given to communities having the potential to support an 

urban forestry program.  Financial eligibility is contingent upon communities having a 

standing local government to cooperate with the state and having expressed an interest in 

advancing current urban forestry programs or developing a new urban forest program.   

 

A separate area was created incorporating all the communities the WIDNR believes 

contain tree populations within a defined area that they consider to be reflective of an 

urban forest.  The expertise of the state urban forestry coordinator and regional urban 

forestry coordinators were applied to develop the “Wisconsin urban forest” 

programmatic definition.  All cities (190 total) and villages (395 total) were designated as 

urban areas by the Wisconsin DNR because they represent most densely populated areas.  

For one of the WIDNR (DNRcvt) definitions, selected towns (42 of 1265 total) across the 

state were also added as “urban” on the recommendation of the regional urban forestry 

coordinators.  Towns were included on the basis of existing population centers, urban 

forestry programs, or the potential to support either in the near future.  These towns were 

included as urban communities within the federal Community Accountability Reporting 

System (CARS).  Town inclusion was a qualitative assessment rather than an 
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implementation of quantitative guidelines using the aforementioned criteria as defined by 

the State of Wisconsin in their awarding of grant dollars.  While portions of the 42 towns 

exhibit urban characteristics, it was felt that including the entire town may overestimate 

the area containing urban forest significantly enough that including the towns could be 

counter productive.  Another WIDNR definition incorporating just the cities and villages 

(DNRcv) was also developed for comparison.  It was understood that some of the viable 

urban areas would be missed using just the cities and villages, but the error associated 

with missing a few small developments might be far less than the over estimation error 

introduced by including entire towns.  Area analysis was performed on both approaches 

and comparisons were made to evaluate the influence of the selected towns. 

 

The spatial extent of each area outlined by the three sampling definitions (2000 Census, 

DNRcvt, DNRcv) was incorporated into separate ArcMap 9.1 data layers.  The Wisconsin 

Transverse Mercator 1983 projection was used.  Using this “cookie cutter” approach, 

discrete boundaries were drawn identifying potential sampling areas and gaps in 

sampling areas.  Layers were ‘intersected’ to determine the areas in common between 

definitions.  Differences between the area of a given layer and the area of the ‘intersect’ 

layer were used to determine areas exclusive to each definition.  For example, the total 

area encompassed by the intersected DNRcv/census layer was subtracted from the DNRcv 

layer to yield a spatial representation of area exclusive to the DNRcv definition.  The 

results were compiled into data tables and presented.  This assessment was first and 

foremost designed to work at the statewide level, but ideally it will be able to integrate 
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with the national and statewide FIA data to create a total statewide forest assessment, 

combining data from the rural and urban forest.   

 

The census urban areas/urban clusters were not completely encompassed by the DNR 

definitions so a ‘union’ layer was created to include all areas of both definitions.  This 

broad spatial representation of Wisconsin urban centers was used as a baseline for 

establishing areas eligible for future sample plots.  The spatial analysis determined the 

total possible sample area of the Wisconsin urban forest.   

 

FIA points were plotted to identify what urban areas could be currently sampled using 

the standard FIA methodology.  The total spatial area containing at least one FIA plot 

and an average area per FIA plot was also calculated.  FIA plot locations were 

downloaded in latitude/longitude coordinates and converted for projection in the WTM 

system (http://www.ncrs2.fs.fed.us/4801/FIADB/index.htm).  The plot points used by our 

study were likely not the exact points defined by the FIA.  There is inherent plotting error 

because the FIA program does not release the precise location of its sample points.  The 

actual point is within a 1.61 km (1 mile) radius of the projected point.  We assumed this 

error was negligible based on the fact that the number of missed points falling inside the 

urban areas was equal to the number of points falling outside urban areas that were 

wrongly included.  
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CHAPTER 3 

TOWARDS A UNIFIED URBAN FOREST AND URBAN FORESTRY 

DEFINITION 

 

Abstract: Jorgensen coined in 1965 and published in 1970 the first formal definition of 

urban forestry.  Moeller proposed the first definition of the urban forest in 1977.  Since 

then many competing urban forest and urban forestry definitions have been proposed.  

This paper summarizes key attributes of these definitions. We examined through content 

analysis 77 definitions found within peer-reviewed papers, secondary literature, and other 

urban forestry publications. We asked three questions.  First, what attributes were used 

within these definitions and how frequently were they used.  The attributes were 

partitioned within six categories; people based, geographically located, benefit 

producing, resource containing, activity involved, and science supported.  Second, have 

definitions evolved to broaden the scope of the urban forest and urban forestry 

envisioned by Jorgensen and Moeller.  Third, have categories found within Jorgensen 

and Moeller lost favor in more recent definitions through contemporary thought of what 

constitutes the urban forest and urban forestry.  Our study found that while numerous 

definitions have been drafted since Jorgensen’s and Moeller’s first definitions, 

subsequent definitions have neither added to nor lessened the significance of their work.  

Most were simplifications or partial representations.  The commonality of attributes 

found within each category grouping is also presented. 

 
Key Words: Urban Forest, Urban Forestry, Definition, Urban and Community Forestry, 
Urban Forestry Model 

23 



Introduction 

 

In 1970, Jorgensen proposed that urban forestry is “a specialized branch of forestry and 

has as its objective the cultivation and management of trees for their present and 

potential contributions to the physiological, sociological, and economic well-being of 

urban society.”  Jorgensen also believed urban forestry went beyond “…city trees or with 

single tree management, but rather with the tree management in the entire area 

influenced by and utilized by the urban population.”  Moeller (1977) proposed the first 

definition of the urban forest: “The urban forest is a flexible concept that encompasses 

rows of street trees and clusters of trees in city parks, green belts between cities and 

eventually forests that are more remote from the inner city.  The urban forest occupies 

that part of the urban ecosystem made up of vegetation and related natural resources 

found in urban, suburban, and adjacent lands, regardless of ownership.  As we move 

across the urban-rural gradient, the mix of benefits provided by the urban forest changes.  

The limits of the urban forest cannot be defined by a line on a map.  More importantly, 

the urban forest provides a conceptual framework within which to organize a research 

program to maximize the benefits that forests can contribute to improving urban 

environments.”  Definitions of the urban forest and urban and/or community forestry 

provide the basis for defining the extent, management, and function of urban forest 

resources and the influence from and for human populations (Konijnendijk et al. 2006). 

 

The concept and definition of urban forestry (what you do) and urban forests (what you 

have) has been steeped in controversy over time with competing definitions and scholarly 
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attempts to explain and refine the terminology (Rowntree 1988, Grey 1996, Dobbertin 

and Prüller 2002, Dobbertin et al. 2002, Konijnendijk 2003, Konijnendijk et al. 2006).  

An extensive search by Hauer (2005) of the literature found nearly 80 definitions for 

urban forestry and urban forests since 1970 (Appendix A).  Konijnendijk et al. (2006) 

suggest the need to harmonize urban forestry terminology to improve comparability, 

compatibility, and provide consistency with definitions. 

 

Many concepts, terms, and definitions pertaining to trees and other woody and 

herbaceous vegetation and/or their management in and near urban areas have been 

developed.  These include urban green, urban greening, urban greenery, urban green 

spaces, community forestry, urban and peri-urban forestry, metro forestry, city forestry, 

town forestry, municipal forestry, amenity forestry, environmental forestry, Stadwald, 

stadsbos, stadtforst, and urban and community forestry (Miller 1997, Forest et al. 1999, 

Konijnendijk 2000, Konijnendijk 2003).  Even though these terms and associated 

definitions delimit an expressed meaning for the management of the urban forest, 

similarities among these do exist.  Commonalities among definitions include statements 

that the urban forest is a geographically defined resource which people are a part of and 

realize the benefits (also liabilities) produced.  Differences in the spatial extent, 

disciplinary interest and social acceptance of the urban forest have complicated attempts 

to develop a unified definition of the urban forest (Payne and Gallaher 1979, Shafer and 

Moeller 1979, Rowntree 1988, Konijnendijk 2003, Randrup et al. 2005). 
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Urban forestry involves activity based on building of science to support perpetuation of 

the resource.  Additionally, urban forest management has traditionally relied upon many 

disciplines (e.g., foresters, arborists, horticulturalists, landscape architects, entomologists, 

pathologists, soil scientists, etc.) to care for the resource and their interpretations may 

differ (Miller 1997).  As an early example, Abbott (1970) suggested the USDA Forest 

Service should title their newly developing urban and community forestry (U&CF) 

efforts as urban arboriculture to better reflect the activities performed on a routine basis.  

The importance of defining terms adequately and correctly was also stressed early on in a 

ruling that stated shade tree work is not horticulture and therefore allowed shade tree 

workers to become certified in a labor union (Anonymous 1970).  The Ontario Labor 

Relations Act did not apply to horticultural workers who were defined as involved with 

cultivating and tilling a piece of ground for the cultivation of plants because shade tree 

workers did not prepare soil.  Finally, definitions can change over time based on new 

knowledge and societal changes (Konijnendijk et al. 2006).  Incorporation of these 

changes reflects a changing society and evolution of urban forestry. 

 

Regardless of the definition used, concepts and definitions that make up a discipline’s 

professional vocabulary are important for the assessment, planning, and management of 

urban forests.  Measurement, enumeration, and analysis of urban forests is dependent 

upon what is studied as much as the extent to which conclusions regarding the forest 

resource are made (Rowntree 1988, Konijnendijk et al. 2006).  Urban forest planning and 

management requires defining the spatial extent to which management is going to be 

applied and the recipients of the net societal contributions from the forest resource 
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(Rowntree 1986, Dwyer et al. 2000).  Additionally, such spatial clarifications advance 

attempts to quantify the urban forest into clearly defined management zones.  For 

example, Sanders and Rowntree (1984) define the urban forest as “… all outdoor 

vegetation within the legal boundary of a city, including herbaceous, shrub and tree 

canopy layers.”  In this case, the definition clearly articulated what resource comprised 

the urban forest, delineated the management area, and established management 

objectives. 

 

The evidence suggests that a common/succinct definition of the urban forest and urban 

forestry would provide a foundation for the discipline.  Three questions were asked to 

identify commonality among the 77 definitions and to determine if the definitions of the 

urban forest and urban forestry have evolved over the past 40 years.  First, what attributes 

were used within definitions and how frequently were they used.  These attributes were 

partitioned within six category concepts.  The basis for these categories were the 

definitions of the urban forest as defined by Moeller in 1977 and urban forestry as 

described by Jorgensen (1970).  Second, have definitions evolved to broaden the scope 

first envisioned by Jorgensen and Moeller.  Third, have attributes and categories lost 

favor in more recent definitions through contemporary thought of the urban forest and 

urban forestry. 
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Methods 

 

Definitions of urban forestry and the urban forest used in this study were obtained from 

sources published since 1970.  Sources included journals where urban forestry related 

literature is published (e.g., Arboricultural Journal, Arboriculture & Urban Forestry, 

Journal of Arboriculture, Hortscience, Journal of Forestry, Landscape and Urban 

Planning, Urban Forestry & Urban Greening), reviews of urban forestry conference 

proceedings, urban forestry and arboriculture texts, and use of the University of 

Minnesota Urban Forestry Database (http://forestry.lib.umn.edu/bib/urban.phtml).  

 

The definitions by Jorgensen (1970, 1974) and Moeller (1977) were used as standard 

definitions to compare later definitions against.  This served two purposes; 1) to quantify 

changes in the definitions for urban forestry and the urban forest since 1970, and 2) to 

quantify the extent of similarity between later definitions and those proposed by 

Jorgensen and Moeller.  In other words, did Jorgensen and Moeller use concepts that 

were later rarely used in proposed subsequent definitions. 

 

Content analysis was used to delimit attributes within each definition for both the urban 

forest and urban forestry.  Attribute frequency counts were derived from the number of 

definitions that included a particular attribute (Table 3.1).  Each attribute was represented 

for its presence or absence within a definition.  Attributes were classified into six 

categories: (1) people based, (2) geographically located, (3) benefit producing, (4) 

resource containing, (5) activity involved, and (6) science supported.  Most attributes 
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were included within one category; however the attributes urban, city, village, towns, and 

suburb, however, were included in both the people and geography categories.  By 

definition, these attributes may be interpreted to reflect a focus on people and a 

geographical area.  Within the benefit producing category, subcategories were added to 

classify attributes within either ecologic/environment, sociological, or economic benefits 

provided by urban trees.  A percentage of definitions containing reference to each 

category, subcategory, and attribute was then generated.   

 

Results 

 

There were 19 unique urban forest and 58 unique urban forestry definitions found within 

the literature and used in this study (Appendix A).  No published definitions of urban 

forestry were found prior to 1970.  The first urban forestry definition presented by 

Jorgensen (1970) contained all 6 definition categories (people, geography, benefit, 

resource, activity, science).  The first definition of the urban forest was provided by 

Moeller (1977) and referenced four specific categories (people, geography, benefit, and 

resource).  Definitions proposed since Jorgensen and Moeller varied in length and the 

number of categories and attributes represented within a category (Tables 3.2 through 

3.8).  In no case did a more recent definition contain a new category. 
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Table 3.1. Six categories and attributes within a category used to describe urban forest 
and urban forestry definitions. 
 

A) People Based 
Urban 
Community 
City 
Village 
Town 
Suburb 
Local Government 
Population 
Concentration/Density 
Civilization 
People 
Man 

B) Geographically 
Located 

Urban 
Urbanizing 
Peri-urban 
Suburban/Fringe 
Adjacent Land 
Rural 
All 
City 
Town 
Village 
Public 
Private 
Community 
Greenspace 
Park/Street 
County 
Municipality 
Metropolitan 
Man's Environment 
Social/Urban Interface 
Reclaimed 
All Lands 
Area We Live 
Urban Woodland 
Watershed 
Populated Place 
Population 
Concentration/Density 

C) Benefit Producing 
 
1) Ecologic/environment 

Wildlife 
CO2 Sequestration 
Shade 
Windbreak 
Air Filter 
Noise Reduction 
Soil 
Glare 
Municipal Watershed 

 
2) Sociological 

Recreation 
Cultural 
Community 
Health 
Physiological 
Sensory 
Landscape 
Ornament 
Engineering 
Architectural 
Psychological 

 
3) Economic 

Recycling 
Ameliorating 
Aesthetic 
Amenity 
Windbreak 
Energy 
Real estate 
Food 
Wood Products 

D) Resource Containing 
Forest 
Tree 
Shrub 
Lawn/Turf 
Water 
Soil 
Wildlife 
Urban Plants/Woody 

Veg 
 
E) Activity Occurring 

Planning 
Management 
Cultivation 
Protection/Conservation
Maintenance/Care 
Design 
Improvement 
Establishment 
Anything 
Utilization 
Wise Use 

 
F) Science Surrounding 

Professional 
Specialized 
Art 
Discipline/Practice 
Systematic 
Science 
Technology 
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Each urban forest definition contained, on average, 3 categories (median 3, mode 3), and 

ranged between 2 and 4 categories (Table 3.2).  Each urban forestry definition contained, 

on average, 4 categories (median 4, mode 4) and ranged between 2 and 6 categories.  

Geography (100%), resource (100%), and people (89.5%) were the most common 

categories within urban forest definitions (Table 3.2).  The least mentioned category was 

benefits (26.3%).  Within the urban forestry definitions, geography (96.6%), activity 

(93.1%), and resource (89.7%) were the most commonly cited categories within 

definitions and fewer of these referenced benefits (55.2%) or science (32.8%).   

 

Table 3.2. Commonality of category groupings within 77 proposed urban forest and 
urban forestry definitions. 
 

 
 Urban Forest (n=19) Urban Forestry (n=58) Both (n=77)
Category Number Percent Number Percent Number Percent 
 

Geography 19 100.0 56 96.6 75 97.4 
Resource 19 100.0 52 89.7 71 92.2 
People 17 89.5 50 86.2 67 87.0 
Activity 0 0.0 54 93.1 54 70.1 
Benefits 5 26.3 32 55.2 37 48.1 
Science 0 0.0 19 32.8 19 24.7 

 

 

People Attributes: Ten different people attributes were identified in the definitions.  The 

most commonly cited people attributes for the urban forest were urban (36.8%), 

population density (21.1%), and community (15.8%) (Table 3.3).  The dominant people 

attributes of urban forestry definitions were urban (70.7%) and community (22.4%).  

Other attributes including city, town, suburb, people, man, village, and civilization were 

included but overall found in less than 10% in both urban forest and urban forestry 

definitions (Table 3.3). 
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Table 3.3. Frequency of attributes within the category people from urban forest (n=19), 
urban forestry (urban forestry n=58), and both (n=77) definitions combined. 
 

 
Urban Forest Urban Forestry Both

Category Attributes Number Percent Number Percent Number Percent
 

Urban 7 36.8 41 70.7 48 62.3 
Community 3 15.8 13 22.4 16 20.8 
Population Density 4 21.1 5 8.6 9 11.7 
City 2 10.5 5 8.6 7 9.1 
Town 1  5.3 5 8.6 6 7.8 
Suburb 0 0.0 4 6.9 4 5.2 
People 2 10.5 0 0.0 2 2.6 
Man 1 5.3 1 1.7 2 2.6 
Village 1 5.3 0 0.0 1 1.3 
Civilization 0 0.0 1 1.7 1 1.3 
Any People 
Attribute 17 89.5 50 86.2 67 87.0 

 

 

Geography Attributes:  Twenty-five different geography attributes were identified in 

urban forest and urban forestry definitions.  The most common geography attributes 

within the urban forest definitions included urban (36.8%), adjacent land (36.8%), city 

(26.3%), greenspace (26.3%), and population concentration (21.1%) (Table 3.4).  The 

dominant geography attribute within the urban forestry definitions was urban (70.7%).  

The remaining descriptive attributes were found in less than 13% of both definitions.   

 

Benefit Attributes: Attributes within the benefit category were mentioned infrequently 

(<10.5%) (Table 3.5).  Benefit attributes associated with urban forestry definitions were 

much more prevalent, however, still identified in a minority of definitions.  The most 

common references were within the subcategories economic (36.2%) and sociologic 

(34.5%), followed by the ecologic (22.4%) subcategory (Table 3.5).   
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Table 3.4. Frequency of attributes within the category geography from urban forest 
(n=19), urban forestry (urban forestry n=58), and both (n=77) definitions combined. 
 

 
Urban Forest Urban Forestry Both

Category Attributes Number Percent Number Percent Number Percent
 

Urban 7 36.8 41 70.7 48 62.3 
City 5 26.3 8 13.8 13 16.9 
Adjacent Land 7 36.8 5 8.6 12 15.6 
Greenspace 5 26.3 6 10.3 11 14.3 
Suburban/Fringe 2 10.5 8 13.8 10 13.0 
Park/Street 3 15.8 6 10.3 9 11.7 
Population 
Concentration 4 21.1 4 6.9 8 10.4 
Private Land 1 5.3 7 12.1 8 10.4 
Public Land 1 5.3 7 12.1 8 10.4 
Community 2 10.5 3 5.2 5 6.5 
Social or Urban 
Interface 1 5.3 4 6.9 5 6.5 
Urban Land 2 10.5 3 5.2 5 6.5 
Suburb 0 0.0 4 6.9 4 5.2 
Town 2 10.5 2 3.4 4 5.2 
Man's Environment 1 5.3 2 3.4 3 3.9 
Urban Woodland 0 0.0 3 5.2 3 3.9 
Watershed 0 0.0 3 5.2 3 3.9 
Metropolitan 1 5.3 1 1.7 2 2.6 
Municipality 0 0.0 2 3.4 2 2.6 
Peri-urban 0 0.0 2 3.4 2 2.6 
All 0 0.0 1 1.7 1 1.3 
All Land 0 0.0 1 1.7 1 1.3 
Area We Live 1 5.3 0 0.0 1 1.3 
County 0 0.0 1 1.7 1 1.3 
Populated Place 1 5.3 0 0.0 1 1.3 
Reclaimed 0 0.0 1 1.7 1 1.3 
Rural 0 0.0 1 1.7 1 1.3 
Urbanizing 0 0.0 1 1.7 1 1.3 
Village 1 5.3 0 0.0 1 1.3 
Any Geography 
Attribute 19 100.0 56 96.6 75 97.4 
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Within these subcategories the attribute description that was identical to the subcategory 

(i.e. generic environment, generic sociologic, generic economic) was most common, 

including generic sociologic (25.9%), generic economic (24.1%), and generic ecologic 

(13.8%).  Some definitions also used the word benefit that was not linked to any 

subcategory within the urban forest (10.5%) and urban forestry (15.5%) definitions.  All 

attributes within the subcategories with the exception of the generic benefit (e.g., 

ecologic, sociologic, and economic) and physiological (17.2%) within the sociologic 

subcategory were listed 10% or less of the time in all definitions.   

 

Resource Attributes: Commonly identified urban forest resource attributes were urban 

plants/woody vegetation (57.9%), trees (47.4%), and forest (21.1%) (Table 3.6).  

Likewise, trees (69.0%), urban plants/woody vegetation (29.3%), and forest (26.7%) 

were frequently mentioned describing urban forestry.  Other attributes including, wildlife, 

shrub, water, lawn/turf, and soil were listed in fewer than 10% of all definitions.   

 

Activity Attributes: Within the activity category management (86.2%) and planning 

(29.3%) were most commonly listed (Table 3.7).  Protection/conservation (12.1%) and 

cultivation (10.3%) were also mentioned in more than 10% of the urban forestry 

definitions.  The remaining attributes included establishment, planting, maintenance/care, 

design, anything, improvement, utilization, and wise use, but occurred in less that 10% of 

the definitions. 
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Table 3.5. Frequency of attributes within the category benefits from urban forest (n=19), 
urban forestry (urban forestry n=58), and both (n=77) definitions combined. 
 

 
Urban Forest Urban Forestry BothCategory and 

Subcategory Attributes Number Percent Number Percent Number Percent
 

Ecologic/Environmental 2 10.5 13 22.4 15 19.5 
Generic Ecologic 2 10.5 8 13.8 10 13.0 
Wildlife 0 0.0 5 8.6 5 6.5 
Air Filter 1 5.3 2 3.4 3 3.9 
Municipal Watershed 0 0.0 2 3.4 2 2.6 
CO2 Sequestration 0 0.0 1 1.7 1 1.3 
Glare 0 0.0 1 1.7 1 1.3 
Noise Reduction 1 5.3 0 0.0 1 1.3 
Shade 1 5.3 0 0.0 1 1.3 
Soil 1 5.3 0 0.0 1 1.3 
Windbreak 1 5.3 0 0.0 1 1.3 

 

Sociologic 1 5.3 20 34.5 21 27.3 
Generic Sociologic 1 5.3 15 25.9 16 20.8 
Physiological 0 0.0 10 17.2 10 13.0 
Recreation 0 0.0 6 10.3 6 7.8 
Landscape 0 0.0 5 8.6 5 6.5 
Psychological 0 0.0 3 5.2 3 3.9 
Health 0 0.0 2 3.4 2 2.6 
Community 0 0.0 1 1.7 1 1.3 
Architectural 0 0.0 1 1.7 1 1.3 
Cultural 1 5.3 0 0.0 1 1.3 
Engineering 0 0.0 1 1.7 1 1.3 
Ornament 0 0.0 1 1.7 1 1.3 
Sensory 1 5.3 0 0.0 1 1.3 

 

Economic 2 10.5 21 36.2 23 29.9 
Generic Economic 1 5.3 14 24.1 15 19.5 
Aesthetic 0 0.0 5 8.6 5 6.5 
Wood Products 0 0.0 5 8.6 5 6.5 
Amenity 1 5.3 3 5.2 4 5.2 
Ameliorating 0 0.0 3 5.2 3 3.9 
Energy 0 0.0 3 5.2 3 3.9 
Recycling 0 0.0 2 3.4 2 2.6 
Food 0 0.0 1 1.7 1 1.3 
Real Estate 0 0.0 1 1.7 1 1.3 
Windbreak 0 0.0 1 1.7 1 1.3 

  

 Unspecified Benefit 2 10.5 9 15.5 11 14.3 
 

Any Benefit Attribute 5 26.3 32 55.2 37 48.1 
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Table 3.6. Frequency of attributes within the category resource from urban forest (n=19), 
urban forestry (urban forestry n=58), and both (n=77) definitions combined. 
 

 
Urban Forest Urban Forestry Both

 Category Attributes Number Percent Number Percent Number Percent
 

Trees 9 47.4 40 69.0 49 63.6 
Urban Plants/Woody 
Veg. 11 57.9 17 29.3 28 36.4 
Forest 4 21.1 16 27.6 20 26.0 
Wildlife 1 5.3 4 6.9 5 6.5 
Shrub 2 10.5 2 3.4 4 5.2 
Water 1 5.3 3 5.2 4 5.2 
Lawn/Turf 1 5.3 1 1.7 2 2.6 
Soil 1 5.3 0 0.0 1 1.3 

Any Resource 
Attribute 19 100.0 52 89.7 71 92.2 

 

 

Table 3.7. Frequency of attributes within the category activity from urban forest (n=19), 
urban forestry (urban forestry n=58), and both (n=77) definitions combined. 
 

 
Urban Forest Urban Forestry Both

Category Attributes Number Percent Number Percent Number Percent
 

Management 0 0.0 50 86.2 50 64.9 
Planning 0 0.0 17 29.3 17 22.1 
Protection/Conservation 0 0.0 7 12.1 7 9.1 
Cultivation 0 0.0 6 10.3 6 7.8 
Establishment 0 0.0 5 8.6 5 6.5 
Planting 0 0.0 4 6.9 4 5.2 
Maintenance/Care 0 0.0 3 5.2 3 3.9 
Design 0 0.0 2 3.4 2 2.6 
Anything by a Forester 0 0.0 1 1.7 1 1.3 
Improvement 0 0.0 1 1.7 1 1.3 
Utilization 0 0.0 1 1.7 1 1.3 
Wise Use 0 0.0 1 1.7 1 1.3 
Any Activity Attribute 0 0.0 54 93.1 54 70.1 

 

 
 

Science Attributes:  The least common category of the six primary categories was 

science, with the specialized attribute most commonly mentioned in only 13.8% of the 
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articles (Table 3.8).  A total of 7 science attributes were found.  Those found in less than 

10% of the definitions were art, science, technology, professional, systematic, and 

discipline/practice.  The lack of science attributes for the urban forest is expected since 

the urban forest does not produce science or activities such as planting, maintenance, or 

removal. 

 

Table 3.8. Frequency of attributes within the category science from urban forest (n=19), 
urban forestry (urban forestry n=58), and both (n=77) definitions combined. 
 

 
Urban Forest Urban Forestry BothCategory  and 

Attributes Number Percent Number Percent Number Percent
Specialized 0 0.0 8 13.8 8 10.4 
Art 0 0.0 5 8.6 5 6.5 
Science 0 0.0 5 8.6 5 6.5 
Technology 0 0.0 5 8.6 5 6.5 
Professional 0 0.0 4 6.9 4 5.2 
Systematic 0 0.0 2 3.4 2 2.6 
Discipline/Practice 0 0.0 1 1.7 1 1.3 
Any Science Attribute 0 0.0 19 32.8 19 24.7 

 

 
 

Discussion 

 

Urban forestry is a relatively new addition to the field of forestry.  There was no 

definition for urban forestry within the widely available forestry literature until the 

1970’s (Weck 1966, Jorgensen 1970, Ford-Robertson 1971).  However, urban forestry 

was used as a term in the late 1800’s as part of a Park Commission Report to the City of 

Cambridge, MA (Ricard 2005).   This was also a time in North America for activities and 

programs consistent with urban forestry that were initiated through Shade Tree Wardens, 
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municipal forestry, and arboriculture programs in the late 1800’s (Campana 1999, Ricard 

2005).  

 

This study found that the fundamental definitions offered by Jorgensen (1970) and 

Moeller (1977) are sound.  Changes or additions tend to reflect regional/temporal 

concerns.  All definition categories tended to be mentioned more frequently in the new 

definitions relative to the old definitions.  In some cases, more recent definitions are 

simplifications but still cover the categories and attributes presented by Jorgensen and 

Moeller.  As an example, the definition by Helms (1998) was a concise restatement of 

Jorgensen’s definition, stating that the urban forest comprises the forest resources in and 

around urban community ecosystems for the physiological, sociological, economic and 

aesthetic benefits trees provide society.  Several later definitions borrowed closely from 

the Jorgensen description (e.g., SAF UF Working Group 1972, Nobles 1980, 

Kuchelmeister and Braatz 1993, Helms 1998, SAF 2004, Burley et al. 2004).  Some 

definitions (Arnold 1971, Rowntree 1986, Cramb 1993, Burban and Andresen 1994, 

Tyrvainen et al. 2003) described the urban forest simply as any vegetation around human 

settlement, while others went as far to say that all forestry is urban forestry (Carlozzi 

1971).    

 

This study collectively points to urban forestry as being the management of urban 

vegetation for human benefit in areas impacted by people (Hauer 2005).  Interestingly, 

none of the definitions explicitly stated local citizenry as being involved in the decision 

or planning and management stages.  However, consistent with community forestry in 

 38



third-world rural settings, forestry in urban areas also benefits from a participatory 

process to move urban forest management towards sustainable urban forests based on 

societal desires, ecological integration, and economic inclusion (Clark et al. 1997, Dwyer 

et al. 2003, Thompson et al. 2005).  The six categories from this study provide a basis to 

describe the urban forest and manage it through urban forestry. 

 

People Centered Urban Forest Descriptions 

 

The nearly 90% of definitions that included people attributes reflects an increasingly 

urbanizing society that is escalating the importance of urban forestry and urban 

greenspaces (Miller 1997, Dwyer et al. 2000, Kim 2000, Konijnendijk et al. 2004, 

Nowak and Walton 2005).  This is noteworthy considering 50% of the worlds population 

lives in urban areas and this is expected to reach 75% by the year 2025 (Dwyer et al. 

2000, Kim 2000).  With the attributes urban and community being identified in over 85% 

of the urban forest and urban forestry definitions, attributes have not lost favor over time 

(Jorgensen 1970, Moeller 1977, Miller 1988, Konijnendijk 2003, Burley et al. 2004). 

 

It can also be argued that regardless of location, all forests are important.  Carlozzi (1971) 

suggested that “all forestry is urban forestry” basing his idea on a shift from an agrarian-

based society to an urban-based environment.  During this time period Rhodes (1971) 

suggested the urban population and elected officials will guide management of rural 

forests through their collective value system.  Urban residents are increasingly imposing 

their ideas, values, perceptions, life styles, and vision upon rural forests (Konijnendijk 
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2003, Dwyer and Childs 2004).  More commonly however, forest resources in or near 

concentrations of people are taken to delimit the extent of urban forests (Jorgensen 1970, 

Miller 1997, Forrest et al. 1999, Dwyer et al. 2000, Konijnendijk et al. 2004). 

 

Dwyer and Childs (2004) recently described the movement of people across the 

landscape.  Their formulated thesis is one of a blurring of people across the landscape 

distinguishes a less apparent separation between areas traditionally called urban and rural.  

Rural recreation/amenity areas where residential and recreational communities arise 

through seasonal and permanent homes reflect urban forests through this built 

environment. 

 

Geographical Depictions of the Urban Forest 

 

Geography attributes were most commonly represented, being identified in over 97% of 

all definitions.  The variety of geographical attributes also illustrates the large extent of 

the urban forest.  Areas of dense population (i.e. urban land) have been regularly 

referenced throughout history (Jorgensen 1970, Harris 1983, Nowak 1997, Konijnendijk 

and Randrup 2004).  More recently, adjacent land has been added to the definition 

(Nilsson and Randrup 1997, NUCFAC 1998, Konijnendijk et al. 2000).  Because of the 

proximity of adjacent lands, it is appropriate to include them within the extent of the 

urban forest because of the reciprocal effect they have on urban areas.  Adjacent lands 

provide refuge and benefits similar to trees more centrally located within urban centers. 
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Urban areas within the United States typically consist of a densely populated core with 

great landscape modification.  The degree of modification diminishes asymmetrically 

towards a rural landscape (McDonnell et al. 1997).    Moll (1989) identifies four urban 

forests zones that traverse the land from the rural/urban interface (suburban fringe) to the 

inner city (city center).  Zones may be characterized by canopy cover, lot size, vegetation 

type and origin, tree location, and human population density (Moll 1989).  Hence, 

development of the urban center alters existing landscapes (e.g., forested, agricultural, or 

arid) and future urban forest structure is dependent upon changes to forested or treeless 

land.  Further, in some environments (i.e. arid) the post-development forest canopy 

coverage exceeds pre-development levels (Nowak et al. 1996).   

 

 Urban Forest Benefit Models 

 

Even though the urban forest produces benefits and a rich history of describing this 

exists, less than 50% of all definitions explicitly mentioned benefits.  This is a significant 

oversight when seeking to validate the urban forest and field of urban forestry.  Benefits 

were initially addressed by Jorgensen (1970), but fell out of favor during intermediate 

years (Nobels 1980, Wenger 1984, Stevens and Rowntree 1989).  Their recognition 

within the literature has increased in recent definitions, indicating increased appreciation 

and awareness of the resource (Nowak 1997, Helms 1998, Gilliland 1999, SAF 2004).  

Benefits are realized a number of ways and are an important component within the 

proposed definitions. The development of additional urban forest benefit models (i.e. 

UFORE, CITYgreen, etc.) will continue to improve future visibility. 
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Within communities, healthy urban forests promote ecological functioning, provide 

economic returns and enhance social well-being (Westphal 2004, McPherson 2004).  At 

the ecological level, urban forests mitigate air pollution, protect watersheds through 

reduced runoff and erosion, foster energy conservation through shading and the 

moderation of winds, improve soil holding capacities, and provide wildlife habitat 

(McPherson 2004, Dwyer et al. 2000).  Urban forests also foster a healthier society by 

improving air quality through reducing air pollutants (Nowak et al. 2002).  Urban forests 

contribute to the economic well being of communities through increased shopping in 

treed retail centers, enhanced property values, the professional livelihood of those that 

care for urban tree populations and landscapes (Nowak et al. 2002, Wolf 2005).   

 

Sociologically, urban vegetation has been linked to reduced crime rates, enhanced 

psychological well-being, expanded outdoor recreation opportunities and the creation of 

conditions leading to enhanced human fitness (Coley et al. 1997, Kuo et al. 1998, Dwyer 

and Barro 2001). People also passively benefit from nature.  Nature, when viewed from a 

window at work, led to greater job satisfaction and emotional well being (Kaplan 1993).  

Similarly, visits to a local park may help relieve or mitigate stress (Hull and Michael 

1993).  Ulrich (1984) demonstrated that when exposed to a view of the natural world 

through a window patients spent less time in a hospital than those without such a view.  

People were also found to have less stress with regular contact with nature (Ulrich et al. 

1991). 
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Social interaction is increased in treed and vegetated areas and subsequently higher levels 

of social cohesiveness among neighbors (Kuo et al. 1998, Coley et al. 1997).  Urban 

forestry programs can foster safer communities by providing the citizens with a sense of 

ownership within the public space (Kuo 2003).  Areas that have natural world attributes 

help develop stronger neighborhood ties, have been correlated with reduced child abuse, 

foster greater physical and mental health, and are more commonly used as centers of 

outdoor recreation (Kuo 2001).  Ironically, even though outdoor recreation can be 

promoted through urban forestry efforts, urban forestry texts have limited suggestions as 

to how urban forest management practices can be direction to provide recreational 

opportunities (Bradley 1995, Grey 1996, Miller 1997, Manning 1999, Anderson et al. 

2000). 

 

Resource Comprising the Urban Forest 

 

Urban forests are ecosystems characterized by the presence of trees and other vegetation 

in association with people and their developments (Miller 1997, Dwyer et al. 2000).  The 

urban forest as such a resource was captured in over 90% of definitions.  The urban forest 

resource includes vegetation on public (parks, road right of ways, public green areas) and 

private lands.  A national assessment of the urban forest resource within the contiguous 

48 states found that 3.8 billion trees exist within urban areas and 74.4 billion trees in the 

greater metropolitan region (Dwyer et al. 2000).  Street trees only constitute 

approximately 10% of the urban forest within Chicago, IL (McPherson et al. 1994), 

necessitating the inclusion of trees on residential and commercial property. 

 43



 

Within the physical bounds of the urban forest, management is associated with a specific 

resource base.  Trees are an important component of the urban forest that has historically 

been the major focus of management (Andresen 1976, Jorgensen 1970, Harris 1983, 

Helms 1998).  Trees are an important contributor through benefits such as shade and 

carbon sequestration (McPherson et al. 1994).  Trees tend to be the longest lived urban 

vegetation and therefore grow to be significant contributors to the urban landscape.  

While significant, trees are not the sole providers of urban greening and its associated 

benefits.   

 

The more generic term of all urban plants/woody vegetation was even more prevalent 

than definitions that only included trees.  Several definitions explicitly stated all plants 

contribute to the benefits associated with urban vegetation (SAF UF Working Group 

1972, Grey and Deneke 1986, Miller 1997).  These definitions included woody and 

herbaceous plants within the urban forest.   

 

Activity Associated with Urban Forestry 

 

A collection of activities associated with the urban forest have been identified throughout 

the literature, typically falling under the generalized umbrella of urban forestry by adding 

an action related to the resource (Miller 1997).  The common inclusion of management in 

definitions suggests the importance of human intervention with growing the urban forest.  

While not as commonly stated, planning was also included in several definitions and 
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places emphasis on a desired approach and anticipated future urban forest.  These 

activities include but are not limited to planning, management, cultivation, and 

conservation (Jorgensen 1970, Burns and Moeller 1979, Costello 1993, Deneke 1993).  

Incorporation of an activity component while defining urban forestry is important to 

illustrate that the urban forest is not a stagnate resource, nor is it self-perpetuating.  

Rather, it is the function of natural regeneration and planting of vegetation.  Urban trees 

are an integral component of the urban environment that must be tended to maximize 

utility and benefits.  Because they exist in dense human settlements, physical 

management must occur to mitigate and remove potential conflicts with man-made 

infrastructure and reduce hazardous situations.  Such mitigation efforts include the proper 

choice of urban friendly trees and their correct placement within the landscape.   

 

Science Validating Urban Forestry 

 

Urban forestry is actively infusing new science and technology into the management 

practices of a historic resource.  It continues to advance as a specialized branch of 

forestry.  The use of terminology commonly associated with the ‘hard’ sciences provides 

an easily identifiable association other scientific professions, essentially creating a sound 

bite validating the field of urban forestry.  The profession of urban forestry has gained 

recognition as a specialized component of forestry (Jorgensen 1970, Moeller 1981, 

Dunster and Dunster 1996).  While being the least frequently mentioned of the six 

identified components, science supporting urban forestry has surfaced regularly in the 

more recent literature (Helms 1998, NUCFAC 2003, SAF 2004, Burley et al. 2004, 
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Konijnendijk and Randrup 2004).  In the past, most assessments were conducted only for 

public trees because that was the resource the municipality was concerned with 

maintaining.  The development of new assessment technologies and methods have 

allowed for drawing more inclusive boundaries.  Satellites are now capable of delivering 

cost effective fine (<1 meter) resolution imagery that could possibly deliver very accurate 

urban canopy assessments.  The data acquired from a canopy study can then be used 

within benefit models such as UFORE to quantify the resource.  The growing use of other 

technologies such as GPS and GIS improve the mapping and tracking capabilities of 

municipalities to monitor the urban forest.  Landscape designs can then be modeled and 

implemented to use urban vegetation most effectively.   

 

Conclusion 

 

Developing a standard definition for urban forestry and the urban forest is important to 

advance this discipline forward using common language others can agree on.  Textually 

defining the location and attributes the urban forest includes is vitally important for 

establishing a spatial definition for assessment.  Without an outline of textual attributes 

comprising the urban forest and urban forestry, creating defensible sampling boundaries 

is considerably more difficult.   

 

From this study, more recent urban forest definitions did not add to that proposed by 

Moeller.  Thus, it is fitting to use the first proposed definitions of the urban forest unless 
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justification can be found to do otherwise.  We found no such evidence, and therefore 

propose it as the definition of the urban forest.     

 

The definition of urban forestry proposed by Jorgensen laid the base for the modern 

definition we are proposing.  The definition by Helms (1998) is a more concise and was 

also the first to directly include the ‘art, science, and technology’ aspect to defining urban 

forestry.   Including art, science, and technology within the definition lends more 

credibility to the field of urban forestry as a scientific discipline.  Such as, the definition 

by Helms (1998) is a concise statement of urban forestry.    
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CHAPTER 4 

SPATIAL REPRESENTATION OF THE WISCONSIN URBAN FOREST 

 

Abstract: The state of Wisconsin is developing and implementing a statewide urban 

forest assessment.  Before sampling could begin, the extent of the urban forest needed to 

be delineated.  This paper explains how a set of programmatic definitions was developed 

to spatially represent the extent of the urban forest.  The definitions that were used 

include the 1) census 2000 definition of urban areas and urban clusters, 2) all cities and 

villages, and 3) all cities, villages and selected towns.  Data layers were downloaded and 

created using ESRI Arc 9.1 software.  The three primary definitions were analyzed to 

weigh the similarities and dissimilarities associated with each method.  The goal was to 

create the most inclusive definition without grossly under or overestimating the extent of 

the urban forest resource.  We determined that using a combination (union) of the 2000 

census definition coupled with the cities and villages yielded the most representative 

statewide sample set. 

 

Key Words: Urban Forest, Statewide Assessment, Spatial Definition 
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Introduction 

 

Urban forests are an integral portion of the urban environment and they directly influence 

the daily lives of nearly 80% of the United States population (Dwyer et al. 2003).  Urban 

forests are ecosystems characterized by the presence of trees and other vegetation in 

association with people and their developments (Miller 1997, Dwyer et al. 2000).  

Contemporary urban forests evolved from city beautification efforts and the architectural 

functionality associated with trees (Campana 1999, Miller 1997).  Even with this, the 

concept of the urban forest as a fundamental, working component of the urban landscape 

and the associated benefits are not well understood or widely recognized by the public 

(Hull 1992).  Interestingly, however, the majority of people believe their communities are 

better places to live because of trees and other plants in the urban environment 

(Elmendorf et al. 2003, Schroeder et al. 2003, Lohr et al. 2004, Treiman and Gartner 

2005).  There is great value with the amenity functions of urban vegetation (Miller 1997).  

However, urban forests have additional environmental and economic values that are 

especially useful to support integration of trees and associated vegetation into urban 

landscapes. 

  

Urban and metropolitan areas that support substantial forest resources have the potential 

to significantly improve the ecologic and economic quality of the urban environment and 

the well-being of its residents (Dwyer et al. 2003).  For example, the urban forest 

contributes to the removal of air pollution, sequestration of atmospheric carbon dioxide, 

hydrologic benefits, and energy conservation (McPherson et al. 1994, McPherson 2004).  
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These benefits result in saving billions of dollars a year in equivalent control costs 

(Nowak et al. 2002).  Urban vegetation also has been linked to social benefits such as 

reduced criminal activity and improved human health (Kuo and Sullivan 2001a, Kuo and 

Sullivan 2001b, Taylor et al. 2001, Kuo 2003).  In addition, a positive correlation exists 

between vegetation and commerce and this translates into a more vibrant business 

community (Wolf 2005). 

 

The introduction of exotic pests such as Asian longhorned beetle (Anoplophora 

glabripennis) and emerald ash borer (Agrilus planipennis) demonstrates the need to 

accurately assess tree populations across the entire landscape.  For example, the estimated 

maximum potential national urban impact of infestations by A. glabripennis is $669 

billion (Nowak et al. 2002).  As such, a complete understanding of urban forest structure 

at smaller scales is needed to accurately prepare for the impact of exotic pest infestations. 

 

Knowing where vegetation exists, species distributions, size classification of trees, insect 

and disease issues, and locations where vegetation can be integrated into the urban 

landscape is important for managing the urban forest and fostering improved urban 

environments.  Dwyer et al. (2000) compiled a national assessment of the urban forests as 

a basis of the resource within the contiguous 48 states.  The assessment estimated there 

were 3.8 billion trees within urban areas and 74.4 billion trees in the greater metropolitan 

regions.  The assessment scale, however, was not suitable for local urban forest profiles 

of species composition and delimiting sizes of trees (Nowak et al. 2002).   
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Different approaches have been used to measure urban tree cover and species 

composition (Nowak et al. 1996).  Complete ground-based inventories are one possibility 

for small populations (e.g., tens, hundreds, or a few thousand trees), but they require 

considerable time and money to conduct (Rideout 2006).  A more efficient approach for 

complete inventories with large populations is the application of remote sensing sampling 

methodologies.  Remote sensing technology may be used to coarsely survey the urban 

forest resource.  Sensors such as the Landsat-5 Thematic Mapper (TM) can record 

reflectance from 30 meter ground cells in 7 wavebands of the spectrum (Bolstad 2005).  

Wavebands are used to identify vegetation (tree canopy and grass) and impervious 

surfaces based on the reflectance values.  Satellite imagery and aerial remote sensing can 

indicate the presence or absence of vegetation within an urban environment (Lillesand 

and Kiefer 2000), yet they are not reliable for identifying the species of an individual 

tree.  The inherent limitations of remote sensing due to spatial resolution can be 

addressed through field verification, but doing so requires additional time and effort.  

This type of technology is useful for assessment of canopy area within an urban setting.  

Field verification is an important method to confirm remote sensing based field estimates. 

 

Estimating the urban forest through fixed area sample plots on the ground is another 

method to determine urban tree population structure (McPherson et al. 1994, Nowak and 

Crane 2000).  Another ground survey method uses the United States Forest Service 

(USFS) Forest Inventory and Analysis (FIA) nationwide sample plot grid initially 

developed to assess the rural forest resource.  The FIA plots that fell within urban areas 

have been used to estimate the urban forest resource with mixed results (Riemann 2003, 
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Nowak et al. 2005).  Within these studies the sample plots were established within 

political boundaries, which can be too restrictive, but enable simplified geographical 

representation.  

 

On a local, city or even county scale, many inventories have been conducted for public 

trees (Nowak 1997).  The vegetation included within these surveys is located on the 

public right of way, in park settings, and other public green areas.  This seriously under-

represents the actual urban forest regardless of the scale.  In Chicago, IL only about 10% 

of trees are street trees (McPherson et al. 1994).  As a result, vast misrepresentation of 

urban forest structure is possible unless public and private trees are accounted for within 

an urban forest assessment.  While the geographical sphere of influence stretches beyond 

the borders of urban areas, assessing the urban forest requires boundaries.  A fully 

inclusive assessment methodology is, therefore, needed to quantify both public and 

private trees in a city or state urban forest inventory.  The FIA assessment can be scaled 

to state and regional levels but it looses reliability because it is too coarse for those levels.  

A gap exists between the national assessment and local assessments.  An assessment that 

bridges this gap to provide reliable data at the state, county or city level is needed 

(Rideout 2006).  Furthermore, quantification of the urban forest resource representative 

of the statewide urban forest is needed to support statewide urban forestry planning. 

 

Preliminary nonforest and urban sampling methodologies have been developed in at least 

three states (Maryland, Massachusetts, Wisconsin) to address the lack of reliable data 

about the urban forest at county and state levels.  The State of Maryland used the USFS 
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forest health monitoring protocol to sample street trees (Cumming et al. 2001).  Another 

pilot study within a five county area in Maryland utilized a modified FIA approach with 

very positive results, including future recommendations for plot design and sampling 

methodology (Riemann 2003).  Results in other locations using FIA based methods, 

including Wisconsin, have been mixed due to an insufficient number of FIA sample plots 

(Nowak et al. 2005).  In the Wisconsin pilot study Eastern hophornbeam (Ostrya 

virginiana) was determined to be the most common urban tree (Nowak et al. 2005).  

Common and frequently planted urban species such as green ash (Fraxinus 

pennsylvanica), white ash (Fraxinus americana), and American elm (Ulmus americana) 

were not within the top five.  The data would suggest either the wrong areas were 

sampled (not truly urban areas) or correct areas were under-sampled (Nowak et al. 2005, 

Miller and Miller 1991). 

 

Wisconsin, like many states, does not currently have a statewide urban forest assessment.  

In the process of implementing a statewide assessment, the spatial extent of urban areas 

must be established before sampling can begin.  Currently there is no recognized or 

generally accepted definition for the spatial extent of the urban forest.  Dwyer et al. 

(2000) used an approach that delineated the national urban forest based on the 1990 

census definition of what geographically defines an urban area.  The 1990 census defined 

urban areas as having at least 2,500 people or a population density of at least 384 

people/km2 (1000 people/mi2).  In contrast, state urban & community forestry (U&CF) 

programs often define the urban forestry from a programmatic point.  Amherst, WI is an 

example of a community excluded by the census definition, but still qualifies for urban 
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forestry assistance dollars under the Wisconsin Department of Natural Resources 

(WIDNR) definition. 

 

The primary objective of this project was to develop and compare the spatial extent of 

Wisconsin urban areas using 3 different definitions.  The 2000 US Census Bureau 

definition of urban areas developed a primary area of interest, yet because it is based 

strictly on population density; it may omit areas of interest to the WIDNR.  For that 

reason, two programmatic WIDNR definitions were developed to more accurately reflect 

areas of interest to the WIDNR for funding and assessment purposes.  One incorporated a 

combination of cities, villages, and selected towns and a second included only cities and 

villages within Wisconsin.  Additionally, FIA points were plotted over the areas 

represented by each definition to determine if FIA sample plots adequately reflected 

urban areas.   

 

Methods 

 

Three approaches were used to delineate the spatial extent of the urban forest in 

Wisconsin.  These approaches included the 2000 US census definition of an urban area 

and two programmatic definitions of the urban forest based on cities, towns, and villages 

that were developed by the WIDNR Urban and Community Forestry (U&CF) program.  

The WIDNR definitions reflect urban and built environments that support or have the 

potential to U&CF programs without regard to population and would be, based on the US 

census definition, might be excluded from a statewide assessment of the urban forest.  
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The first programmatic definition incorporated all cities (incorporated community with at 

least 1,000 citizens if it is in a rural area or 5,000 citizens if it is in an urban area) and 

villages (incorporated community with at least 150 citizens if it is in a rural area or 2,500 

citizens if it is in an urban area) of record in 2005.  The second programmatic WIDNR 

U&CF definition included all cities, villages and a subset of selected towns that reflect 

characteristics (managed tree population, tree board, etc.) consistent with an urban forest.  

These were communities identified as urban by the federal Community Accountability 

Reporting System (CARS). 

 

Census Approach: The 2000 US Census Bureau data and classification served as the 

starting point for assessment area analysis because it is easily replicable and is proposed 

as the new standard for national and state U&CF assessments in the United States.  The 

2000 census definition uses population density to establish urban areas.  Census block 

groups with a population density of at least 384 people/km2 (1,000 people/mi2) and 

surrounding census blocks with an overall density of at least 192 people/km2 (500 

people/mi2) define an urban area.  Census data were downloaded from ESRI in October 

2004 (http://www.esri.com/data/download/census2000_tigerline/index.html).  Data from 

each county was merged in ArcMap 9.1 to create a statewide urban area.  

 

Programmatic DNR Based Approach: The Wisconsin DNR has a programmatic 

definition of the urban forest that includes the political boundary of a city, village, or 

town.  Many of these communities fall within 2000 census-based-population densities 

consistent with urban areas.  The first definition includes all cities, villages, and selected 
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towns (DNRcvt) and the other includes only cities and villages (DNRcv).  All cities (190 

total) and villages (395 total) were designated as urban areas in both programmatic 

definitions.  Programmatically the communities either administer or have the potential to 

administer U&CF technical and/or financial assistance to these areas; they represent 

densely populated areas or built environments perceived by WIDNR U&CF staff to be 

consistent with CARS.  The CARS system is a USFS standard for defining urban forest 

communities within a state.  Using this system, a few towns (42 of 1,265 total) were also 

considered as urban forest areas based on their inclusion in CARS (DNRcvt).  Some of the 

viable urban areas would be missed by not incorporating the selected towns, but it is 

believed that the error associated with missing a few small developments would be far 

less than the over estimation error introduced by including entire towns. 

 

The spatial extent of each area outlined by the three sampling definitions was 

incorporated into separate ArcMap 9.1 data layers using the Wisconsin Transverse 

Mercator 1983 projection (Appendix B).  It was assumed that all of the area designated 

urban by the census was relevant to spatially delineate the urban forests in Wisconsin and 

that the WIDNR programmatic definitions represented additional areas with urban 

forests.  A union layer was created using the 2000 census layer with each DNR definition 

separately.  The union included all area from either definition.  A census comparison was 

also done to investigate the changes between the 1990 census and 2000 census.  The 

spatial extents of each layer were compared to identify areas unique to each definition 

and to determine the total and mean number of FIA plots found within each spatial 

definition and the percentage of polygons (communities or census block area) that 
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contained at least one FIA.  If a polygon included an FIA sample point, the area of the 

entire polygon was included.  The total potential urban area included all definitions. 

 

Results 

 

Three spatial definitions differed in the total number of communities captured and spatial 

extent (Figure 4.1).  The DNRcvt had the greatest number of communities with 626 and 

largest area 1,225,010 ha (3,027,066 ac).  The DNRcv had fewer communities (584) and 

less area 629,654 ha (1,555,908 ac).  The census 2000 approach identified 115 

communities with an area of 427,949 ha (1,057,446 ac) (Table 4.1).  The DNRcvt 

contained approximately 2.9 times more area than the 2000 census, while the DNRcv was 

approximately 1.5 times larger than the 2000 census area.    

 

Comparisons were made to investigate the amount of overlap for each of the DNR 

definitions relative to the 2000 census (Figure 4.2).  The area in common between the 

DNRcvt and 2000 census totaled 342,290 ha (845,818 ac) and was greater than similar 

area covering 310,023 ha (766,084 ac) between the DNRcv and 2000 census (Table 4.2).  

The DNRcv delineated 789,824 ac (50.8%) unique area and the DNRcvt 2,181,248 ac 

(72.1%) unique area relative to the 2000 census spatial area.  Of the total area in the 

WIDNR programmatic definitions, only 49.2% of the DNRcv and 27.9% DNRcvt of the 

total area within these was in common with the census 2000 spatially delineated area.  

The additional area included within the DNRcvt definition included population centers 
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falling within towns which was 1,471,158 ac or 48.6% greater than the area within 

DNRcv. 

 

Table 4.1. Area encompassed by three spatial definitions of the urban forest in 
Wisconsin. 
 
 

Spatial 
Definition 

Area 
(acres) 

Area 
(hectares) 

Percent of 
2000 

Census 
Percent of 

DNRcv

Percent of 
DNRcvt

 
2000 Census 1,057,446 427,949 100.0 68.0 34.9 
DNRcv 1,555,908 629,654 147.1 100.0 51.4 
DNRcvt 3,027,066 1,225,010 286.3 194.6 100.0 

 
 

DNRcv – Programmatic definition includes cities and villages only 
DNRcvt – Programmatic definition includes cities, villages, and towns  

 

Table 4.2. Comparisons of two programmatic spatial definitions of the urban forest in 
Wisconsin to the 2000 US census definition. 
 
 

Spatial 
Comparison 

Total Area 
(acres) 

Unique 
Area 

(acres) 
Percent 
Unique 

Common 
(acres) 

Percent 
Common 

 
DNRcv to 2000 
Census 1,555,908 789,824 50.8 766,084 49.2 
DNRcvt to 2000 
Census 3,027,066 2,181,248 72.1 845,818 27.9 

 
 

DNRcv – Programmatic definition includes cities and villages only 
DNRcvt – Programmatic definition includes cities, villages, and towns 
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Figure 4.1. Spatial extent of the urban forest in Wisconsin using 3 spatial definitions 
2000 US Census Bureau (a), DNRcv (b), DNRcvt (c).  
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Figure 4.2. A comparison of the spatial extent of the Wisconsin urban forest around the 
Milwaukee metropolitan area using the 2000 census exclusive (green), DNRcv exclusive 
(yellow), and areas in common (red). 
 

The area including all the DNRcvt was 3,239,732 acres (1,310,668 hectares) while the 

area using the DNRcv was 1,847,308 acres (747,579 hectares) (Table 4.3).  This increased 

the total area spatially covered by census 2000 by 174.7% through addition of DNRcv 

area or 306.3% through addition of DNRcvt area. 

 

 The new 2000 census definition included 93 more communities and decreased the 

expanse of the boundaries around major urban areas (Figure 4.3).  The area included 

within the 2000 census was 140% of the 1990 census total area (Table 4.4).  There was a 

significant increase in the number of communities considered urban between the two 

census classifications, with 115 urban centers in 2000 compared to just 15 in 1990 (Table 

4.4).   The increase in urban areas does not necessarily reflect explosive population 
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growth, but rather the change in census definition of an urban area between 1990 and 

2000. 

 

Table 4.3. Combined spatial area of two programmatic definitions of the urban forest in 
Wisconsin to the 2000 US census based definition. 
 
 

Spatial Combination 
Total Area 

(acres) 
Percent Common Area / Total 

Area 2000 Census 
 
DNRcv and 2000 Census 1,847,308 174.7 
DNRcvt and 2000 Census 3,238,732 306.3 

 
 

DNRcv – Programmatic definition includes cities and villages only 
DNRcvt – Programmatic definition includes cities, villages, and towns 

 

 

 

 

Figure 4.3. The development and change of census urban areas over 10 years comparison 
between the 1990 census urban areas (a) in contrast to 2000 census urban areas (b). 

a. b.
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Table 4.4. Comparison of the 1990 census and 2000 census used to spatially define the 
urban forest in Wisconsin. 
 
 

Spatial Comparison 
Area 

(acres) 
Area 

(hectares) 
Percent of 

1990 Census 
Percent of 

2000 Census 
 
1990 Census 756,157 306,017 100.0 71.5 
2000 Census 1,057,446 427,949 139.8 100.0 
1990 Census Exclusive 
of 2000 Census 222,235 89,946 29.4 21.0 
2000 Census Exclusive 
of 1990 Census 523,524 211,878 69.2 49.5 
Census 1990 and 2000 
Area in Common 533,922 216,071 70.6 50.5 
Combined 1990 Census 
and 2000 Area 1,279,726 517,887 169.2 121.0 

 

 
 

Over 75% of areas that are considered urban within each definition contained at least 1 

FIA sample point.  The largest percentage of polygons containing FIA points were from 

the 2000 census definition because the census polygons were larger on average than the 

city and village polygons.  The 2000 census polygons also contained the largest average 

number of FIA points.  The larger polygons increased the probability that they contained 

a FIA point because the FIA protocol utilizes a systematic grid.  This also indicated that 

the presence of a single FIA point within a polygon was not a sufficient predictor of 

urban areas. 
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Table 4.5. Comparison of the polygon size for the DNRcv, DNRcvt, and 2000 census areas 
and the FIA points contained within each definition. 
  
 

FIA 
Comparison 

 
Area 

(acres) 
FIA 

Points Polygons 

Area per 
Polygon 
(acres) 

FIA Points 
per Polygon 

2000 Census 980,428 338 83 11,812 4.07 
DNRcv 1,194,670 492 259 4,612 1.90 
DNRcvt 2,665,828 947 301 8,857 3.15 

 

DNRcv – Programmatic definition includes cities and villages only 
DNRcvt – Programmatic definition includes cities, villages, and towns 

 

Discussion 

 

Three potential urban area definitions were used to spatially define the urban forests in 

Wisconsin.  This step is a precursor to initiating a statewide Wisconsin urban forest 

assessment program (Figure 4.1).  The 2000 census definition provided the smallest 

possible sample area, while the DNRcvt definition represented the greatest area (Table 

4.1).  An important question is how three definitions compare.  Political boundaries were 

used to delineate the boundaries around cities, villages and towns, but, not all of the area 

is likely urban or a built environment, resulting in a degree of overestimation of the urban 

forest.  The confidence for projecting urban areas is, therefore, relative to the type of 

community being addressed.  The highest level of confidence occurs for cities and the 

lowest within towns.   

 

Because of their large size and relatively small population centers, towns in Wisconsin 

offer the greatest potential for inflating the urban spatial area.  The majority of the area 

within most towns is managed as something other than urban forest.  For example, there 
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were two small communities within the Town of Menominee, yet most of the town is 

being actively managed as a rural forest.  Interestingly enough, since the tribe manages 

the land for the benefit of the tribe, this forestry is analogous to community forestry.  

Elimination of the selected towns from the DNR definition decreased areas exclusive to 

the DNR definition were decreased 21% (Table 4.2).  While the area exclusive to the 

DNRcv definition is 75% (789,824 ac) greater than the total 2000 census definition area, 

that percentage increased to 206% (2,181,248 ac) greater when using the DNRcvt 

definition.  The percentages reflect a potential overestimation associated with each 

definition by using the 2000 census as a baseline.  Omitting the towns using the DNRcv 

definition underestimated the total urban forest area, but the degree of underestimation 

was less than the degree of overestimation via the DNRcvt definition.  Urban areas within 

towns can be delineated and added to the urban forest assessment of the state. 

 

The combination of the census 2000 and both programmatic definitions represented the 

total possible spatial extent of the urban forest that the WIDNR U&CF program would be 

interested in sampling (Table 4.3).  By not including the towns, the potential urban forest 

of Wisconsin was reduced by 43%.  Because the towns have only small areas considered 

urban, this adds further support that including entire towns would be a significant 

overestimation of urban areas.  In practice, towns in Wisconsin must be further delineated 

to select only those areas that reflect a built environment and therefore, where urban 

forests are likely to exist. 
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In this study some census defined urban areas fell outside of the political bounds of cities 

and villages and this is consistent with what Dwyer and Childs (2004) described.  For the 

WIDNR U&CF program to consider an urban area from a funding perspective there 

needed to be a municipal government in place for the state to deal with (Rideout 2006).  

For example, neighborhood groups (i.e. garden clubs) do not have the political standing 

to receive funding from the state, regardless of initiative, so areas falling outside the 

political bounds of cities and villages were not included.   

 

The most accurate spatial representation is likely some combination of the census and 

programmatic definitions.  The census underestimated the total urban forest extent, but 

did have between 72% and 80% of the area in common with the programmatic 

definitions.  The programmatic definitions likely overestimate the urban forest extent as 

they include the entire bounds of any city, village, or town as an urban area regardless of 

built environments and population density.  Many smaller communities, especially in 

towns in Wisconsin, might not exhibit urban characteristics out to the political boundary 

delineating the city.  We believe that the city classification most accurately represents the 

potential urban area and affords the highest level of confidence, while villages are less 

accurate, and finally towns reflect the lowest accuracy and confidence level for projecting 

the extent of urban areas.  Using a hybrid spatial extent between the census and DNRcv 

yields most of the urban areas and potential urban forests within Wisconsin that would 

meet programmatic needs.   
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Future Work 

 

Establishing the spatial extent of the Wisconsin urban forest is the first step in an 

assessment program.  The next step will be to develop a sampling methodology to reflect 

the assessment goals of the Wisconsin DNR.  Relevant information would include the 

size of sampling plots and sampling intensity necessary to achieve a given level of 

precision.  Sampling intensity information would be very useful in determining the 

feasibility of the assessment program, both in terms of time and money.  The sample plot 

study will establish the best sampling methodology for implementation on the statewide 

level.   

 

The final step in developing the Wisconsin urban forest assessment will be combining the 

spatial extent study with the conclusions drawn from a pilot sample plot study and 

beginning a rotational assessment across the state.  Initially, it is anticipated that a 5 year 

rotational survey would be sufficient for gaining statewide coverage.  As a result, no 

forest data would be older than 5 years, creating a continuously updated database.   

 

By establishing the extent and constituents within the urban forest, more informed 

statewide decisions can be made regarding the resource.  Tree diversity plans could be 

gradually applied to decrease homogenous urban forest populations and potentially 

diminish the damage caused by an exotic pest invasion.  The value of the urban trees 

could also be quantified using models such as UFORE.  The lack of 

appreciation/understanding of the benefits that urban forests provide contributes to the 
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devaluation of urban trees and urban forestry programs by citizens and/or policy makers.  

Recognizing those values and benefits puts the urban forest and its management on a 

similar playing field with respect to the acquisition and use of public dollars relative to 

other municipal responsibilities such as public safety, education, and health care.  Selling 

the significant potential ecological and financial returns on a well maintained urban forest 

could help the tax paying citizens understand that urban trees do far more than reside on 

boulevards and look nice.   

 

Substantial population growth outside urban and metropolitan areas continues to extend 

urban influences to forest resources across the landscape, particularly in places with 

considerable scenic and recreational value (McGranahan 1999).  This is particularly true 

for summer lake communities with relatively few permanent residents and significant 

population increases during the summer recreation months (Dwyer and Childs 2004).  

Using the current census 2000 and programmatic definitions, many of these communities 

would not be considered urban.  However, the trees around and within these areas are 

likely managed as an urban forest.  Changing from a population basis to a built vs. 

unbuilt environment would give a more accurate representation of all urban areas across 

the state.  A further advantage would be the flexibility of incorporating only the 

developed (built) portions of a municipality or town, rather than following a strict 

political boundary. This would yield a more accurate assessment of total urban areas 

across Wisconsin, but could be potentially very labor intensive.  Analysis of aerial 

photography or digital satellite imagery would likely be an easy way to delineate 

boundaries on the statewide level.  Current technology likely makes this option cost 
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prohibitive, but as remote sensing technology improves, this will become a more viable 

option and should be revisited in the future.   

 

A surrogate for determining the built environment that could be tested is an analysis of 

road density.  It is logical that environments with more development have a greater road 

density relative to less built environments.  There are accessible road density layers 

within the Arc program and it would be interesting to compare urban areas to similar road 

densities in out-state areas to determine if it is an accurate predictor of built area. 

 

Another need with urban forest assessment is stratification into different land uses (e.g., 

Residential, Commercial, Industrial, Parks, Roads, Water, Housing Density) and 

determining the practicality to stratify.  Stratification benefits sampling as like land uses 

tend to have similar vegetation patterns.  It further allows for comparison of areas based 

on similar land uses.  Stratification tends to create more robust sample estimates by 

avoiding sampling errors between dissimilar areas.     
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CHAPTER 5 

SUMMARY AND FUTURE IMPLICATIONS 

 

Summary 

 

The two primary goals of this project were to 1) identify a written definition of the urban 

forest and 2) develop a spatial definition for the Wisconsin urban forest.  This thesis 

accomplished both, by identifying the first definition proposals of the urban forest and 

urban forestry to be adopted as a standard and successfully developing a readily usable 

spatial representation of Wisconsin’s urban forest.   

 

A review of the historical literature using content analysis found that Jorgensen (1970) 

provided the first and most complete definition of urban forestry.  Helms (1998) 

simplified Jorgensen and we have slightly modified Helms to create the following 

definition; Urban forestry is defined as the art, science, and technology of managing trees 

and green infrastructure in and around urban community ecosystems for the ecological, 

sociological, and economic benefits trees provide society.  The urban forest can be 

described by borrowing closely from Moeller (1977) and Miller (1988).  The urban forest 

is the trees and any vegetation in and around dense human settlement that provide 

benefits vital to enriching the quality of life.  It is hoped that the definition proposed will 

result in a clearly accepted standard definition for urban forestry and the urban forest.  A 

standardized definition will ease future communication pertaining to the urban forest and 

field of urban forestry.  Implementation of a standard urban forestry definition will also 
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elevate the resource and profession to make it more recognizable.  The urban forest will 

no longer be the forgotten sibling of rural forests.  

 

The programmatic spatial definition of the Wisconsin urban forest is designed for use by 

the WIDNR statewide urban forest assessment.  ESRI Arc 9.1 software was used to 

create a data layer incorporating the 2000 census area with all the cities and villages 

around the state.  The definition is both highly inclusive of relevant areas and easily 

replicable.  With the urban areas spatially defined, the urban forest assessment project is 

able to move forward to sampling and the ultimate goal of a 5 year rotational continuous 

urban assessment. 

 

Future Implications 

 

The next step in implementing a statewide urban forest assessment will be a sample plot 

study to determine the optimal size and spacing of sample plots within urban areas.  This 

will be done to establish the optimal sampling intensity for a desired level of precision.  

The WIDNR will decide what level of precision is ideal and/or financially feasible.  By 

using overlapping sampling windows, statistical precision can be compared between 

sampling intensities.  This method will also help determine at what level of sampling the 

benefits of having more sample sites is outweighed by the additional cost of sampling 

those sites.   
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A potential problem with using population density as the predictor of urban areas is the 

omission of seasonal populations.  Vast parts of Wisconsin are vacation destinations for 

people from urban areas within and outside the state.  Because the summer homes are not 

permanent residences, these areas are not recognized as having large populations.  In the 

summer months, these small city and village populations spike.  It is expected that the 

vegetation around these areas is managed more like an urban area than a rural one.  Thus 

a parameter is needed to look beyond simple population densities.   

 

A comparison between built versus unbuilt environments would be the most accurate 

predictor of the urban forest.  Remote sensing is one method to delineate the boundary 

between the built and unbuilt environment.  While yielding very good results, a statewide 

analysis could take a considerable amount of time and money.  If the resources are not 

available to do a complete remote sensing analysis, road density could potentially be used 

as a surrogate.  Road density is another method to estimate building density and road data 

layers are already available online. 

 

The findings from this research effort will further the study of the urban forest in theory 

and application.  By providing a standard definition, a greater general understanding and 

appreciation of the urban forest should be gained.  On a more local scale, with the 

establishment of a programmatic spatial definition of the Wisconsin urban forest, the 

statewide urban assessment sampling rotations may begin.  The Wisconsin statewide 

assessment is the first of its kind and could serve as a model for other states seeking to 

develop their own statewide urban forest assessments. 
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Appendix – A 
Urban forest and urban forestry definition components 

 
Proposed Definitions of Urban Forestry, and Related Terms Source 
No definition for urban forestry within the forestry dictionary. Weck 1966 
No definition for urban forestry within the forestry terminology 
reference.  The reference does offer definitions for arboriculture 
(The cultivation, i.e. growing and tending, of trees and shrubs, 
individually or in small groups, generally for ornament and 
instruction rather than use or profit.) and community forestry 
(Forest owned and generally managed by a community, e.g. a 
village, town, tribal authority or local government, the members 
of which share in cash, kind, and/or other benefits. 

Ford-Robertson 
1971 

Urban Forestry is a specialized branch of forestry and has as its 
objective the cultivation and management of trees (note: and 
forests added to the 1974 definition) for their present and 
potential contributions to the physiological, sociological, and 
economic well-being of urban society.  These contributions 
include the over-all ameliorating effect of trees on their 
environment, as well as their recreational and general amenity 
value.  (Note: Jorgensen also believed urban forestry went 
beyond “…city trees or with single tree management, but rather 
with the tree management in the entire area influenced by and 
utilized by urban populations.”) 

Jorgensen 1970, 
1971, 1974, 1986 

Urban forestry merely gives forestry a geographic setting, close 
to man’s communities.  Environmental forestry is the 
professional management and protection of forest communities in 
man’s environment for his benefit. 

Arnold 1971 

Environmental forestry is the professional management and 
protection of forest and tree communities in man’s environment 
for his benefit. 

Barber 1971 

…all forestry is urban forestry.  (Note: context based on 
urbanization of a nation from an agrarian society) 

Carlozzi 1971 

Urban forestry is a specialized branch of forestry that has its 
objective the cultivation and management of trees for their 
present and potential contribution to the physiological, 
sociological and economic well-being of urban society.  Inherent 
in this function is a comprehensive program designed to educate 
the urban populace on the role of trees and related plants in the 
urban environment.  In its broadest sense, urban forestry 
embraces a multi-managerial system that includes municipal 
watersheds, wildlife habitats, outdoor recreation opportunities, 
landscape design, recycling of municipal wastes, tree care in 
general, and the future production of wood fiber as a raw 
material. 

Society of 
American 
Foresters Urban 
Forestry Working 
Group 1972 (as 
found in Grey and 
Deneke 1986 and 
Miller 1997) 

Environmental forestry involves those aspects of resource Pinchot Institute 
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management dealing with man’s needs for, and association with, 
the tangible and intangible values of forest vegetation in and 
around metropolitan areas.  Such forested vegetation involves a 
wide range of forest conditions – ranging from city park 
environments to greenbelts and woodlands in rural areas that 
intersperse the huge, sprawling, urban complexes throughout 
Megalopolis. 

1973 

Anything a forester might reasonably do productively in an 
urban-oriented environment. 

Richards 1973 

The application of basic forest management principles in areas 
subject to concentrations of population. 

Stewart 1975 

Urban forestry encompasses the management of trees and forests 
affected by intensive social influence, use, and value. 

Andresen 1976 

Urban forestry is the management of the vegetation in urban and 
urbanizing areas. 

Little 1978 

Urban forestry means the planning, establishment, protection and 
management of trees and associated plants, individually, in small 
groups, or under forest conditions within cities, their suburbs, and 
towns. 

Cooperative 
Forestry 
Assistance Act of 
1978, Nobles 
1980, USDA-FS 
2002 

We view urban forestry as a concept through which the planning 
and management of woody vegetation and green space are 
coordinated and manipulated to provide multiple and sustained 
benefits to urban people. 

Burns and Moeller 
1979 

Urban forestry is the wise use and management of urban 
vegetation.  …  The ultimate goal of urban forestry is to enhance 
the urban setting through the wise use and management of the 
urban forest resource. 

Ehlers 1980 

Urban forestry is a concept that encompasses the planning and 
management of all urban forest resources for their present and 
potential contribution to the physiological, sociological and 
economical health of urban society.  Inherent in this concept is 
the development of an awareness by the urban population of the 
role of natural resources in the urban environment. In its broadest 
sense, urban forestry may relate to street and residential trees, 
urban woodlands, wildlife habitats, open spaces, windbreaks, 
green belts, roadside screens, curbs areas, parks and other areas 
within the urban development capable of supporting vegetation, as 
well as to landscape design, tree care and the utilization of urban 
wood. Urban forestry can and should complement arboriculture.' 

Nobles 1980 

Urban forestry is not a precisely defined profession but a 
conceptual framework through which many specialists can direct 
their talents toward a common goal: to plan, manage, and protect 
urban forest resources in order to produce the largest quantity and 
highest quality of desired benefits.   

Moeller 1981 
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Urban forestry is a dynamic and evolving concept.  This concept 
of urban and community forestry is expanding from its early 
natural focus on street trees to natural resource management 
throughout urban influence zones.  This new concept also 
involves the recognition that an urban values system affects 
management practices on rural forest land.  We find that city 
people still think like city folk even after they move into rural 
areas. 

Deneke 1983 

Urban forestry is the management of trees in urban areas on 
larger than an individual basis.  (Note: also referred to it as a 
specialized form of forestry) 

Harris 1983, 1992 

Urban forestry is the management of publicly and privately 
owned lands in and adjacent to urban areas. 

Wenger 1984 

Urban forestry embraces trees grown in and close to urban areas 
for their value in the landscape, for recreation, and including trees 
in streets, avenues, urban parks, and on land reclaimed from 
previous industrial use, as well as those in urban woodlands and 
gardens. 

Hibberd 1989 

Urban forestry is about planning and managing existing and / or 
new treed vegetation of all types and associated wildlife, to 
establish attractive urban habitats, using systematic forestry-like 
approaches and environmental principles, in combination with 
arboricultural and modified silvicultural techniques. 

Morsink et al. 
1989 

Urban forestry encompasses all the typical activities involving 
trees which occur principally, but not exclusively in urban 
areas. At its most comprehensive it involves the management 
of an entire urban tree population.  Within this broad context, 
the main aims of urban forestry are likely to be centered around 
four basic principles: (i) as all trees within the urban area and the 
urban fringe make some contribution to the urban environment, 
they should, as far as is possible, be managed as one unified 
resource. This includes trees in both public and private 
ownership, (ii) urban trees should be treated as a multi-purpose 
resource with a range of potentials including enhancement of 
the urban landscape and environment, wildlife conservation, 
improvement of recreation experience and the production of 
timber. Trees should be managed to optimize these resources 
thereby improving the quality of life within the urban 
environment, (iii) a community based approach to tree 
management is fundamental. The owners of trees, both public 
and private, should be encouraged to contribute to the 
management of their local environments, taking part in both 
management discussions and implementation. (iv) the urban 
forest must be perpetuated in a healthy state by ensuring 
sufficient planting to counteract tree losses and to enhance the 
total tree resource. 

Lewis 1991 
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The management of trees in urban areas. “management” includes 
planning, planting, and care of trees; “trees” include individual, 
small groups, larger stands, (e.g., green belts) and remnant 
forests; “urban areas” are those areas where people live and work 
(defined by Schoeneman, 1992, as population centers of 100 or 
more people) which can be categorized into four zones (based on 
Miller’s model): downtown, city residential, suburban, and 
urban-rural interface. 

Costello 1993 

Urban forestry is the sustained planning, planting, protection, 
maintenance, and care of trees, forests, greenspace and resources 
in and around cities and communities for economic, 
environmental, social, and public health benefits for people. 

Deneke 1993 

Urban forestry is a specialized branch of forestry that has as its 
objective the cultivation and management of trees for their 
present and potential contribution to the physiological, 
sociological and economic well-being of urban society.... In its 
broadest sense, urban forestry embraces a multi-managerial 
system that includes municipal watersheds, wildlife habitats, 
outdoor recreation opportunities, landscape design, recycling of 
municipal wastes, tree care in general and the... production of 
wood fibre as a raw material. 
Urban forestry is a merging of arboriculture, ornamental 
horticulture and forest management. It is closely related to 
landscape architecture and park management and must be done in 
concert with professionals in these fields as well as with city 
planners.  
Urban forestry includes activities carried out in the city centre, 
suburban areas and the "urban fringe" or interface area with rural 
lands. Forestry activities can differ significantly according to the 
zone. In central areas, the potential for significant new urban 
forestry efforts are relatively limited in most cities. Here, it is 
mainly an issue of maintaining or replacing trees planted long 
ago.  

Kuchelmeister and 
Braatz 1993 

Community and Urban Forestry: is the planning, establishment, 
protection, care and management of trees and associated plants 
individually, in small groups, or under forest conditions within 
municipalities and counties.  It is an opportunity to introduce 
specialized expertise and sensitivity for understanding the 
interrelatedness (ecology) of people, land, water, forests, and 
wildlife. 

McFarland 1994 

Urban and community forestry can be defined as the planning for 
and management of urban and community forests to enhance the 
quality of life for all residents. The process integrates the 
economic, environmental, political, historical and social values of 
the community into a comprehensive management plan for the 
forest. 

NASF 1994 
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Urban forestry deals with the management of all wooded 
vegetation within urban areas. 

Phillips 1993 

Urban forest management is a specialized branch of forestry. It 
includes the planning, designing, establishing, improving, 
maintaining, regulating, treating, conserving, and protecting of 
woody vegetation in urbanized areas. 

DOD 1996 

A specialized form of forest management concerned with the 
civilization and management of trees in the entire area influenced 
and/or utilized by the urban population.  It includes trees on 
streets, in parks, on private property, as well as watersheds.  
Urban forests provide many benefits, including climate 
amelioration, engineering, architectural, and aesthetic uses. 

Dunster and 
Dunster 1996 

That which must be done to make trees compatible and functional 
in the urban environment. 

Grey 1996 

A comprehensive definition of urban forestry may be that urban 
forestry is the planned, integrated and systematic approach to the 
management of trees, shrubs, and other vegetation in urban and 
peri-urban areas for their contribution to the environmental, 
psychological, sociological, and economic well-being of urban 
society. 
For practical reasons and to keep the definition short, flexible and 
understandable by the general public the definition does not need 
to describe all aspects of urban forestry. Therefore urban forestry 
can be simply defined as “the management of urban vegetation to 
meet local need.” 

Kuchelmeister 
1996 

As a practice, urban and community forestry is broadly defined as 
the comprehensive management of forests and related natural 
resources in populated areas, from the inner city to the 
developing urban fringe to small communities.  This includes an 
integration of natural, social, and economic systems as they affect 
and are affected by human activity. 

USDA-FS 1996 

Urban forestry is here defined as planning, design, and 
management of trees and forest stands with amenity value, 
situated in or near urban areas. 

Nilsson and 
Randrup 1997, 
Konijnendijk et al. 
2000 

Urban forestry is the multiple-use management of vegetation, 
particularly trees, in urban areas.  This vegetation is part of a 
complex urban fabric that includes people and many artificial and 
natural surfaces.  Proper urban forest management can enhance 
various social and environmental benefits derived from trees 
(e.g., increased real estate values, improved sense of community, 
reduced energy use and air pollution) while minimizing the costs 
associated with maintaining an urban forest. 

Nowak 1997 

The management of trees and related natural resources in 
populated areas, from the inner city to the developing urban 
fringe and within small communities 

NUCFAC 1998 
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The art, science and technology of managing trees and forest 
resources in and around urban community ecosystems for the 
physiological, sociological, economic, and aesthetic benefits trees 
provide society. 

Helms 1998 

Urban forestry is considered as the planning and managing of 
trees, forests and related vegetation to create or add values to the 
local community in an urban area. 

Kuchelmeister 
1998a 

Urban forestry is considered as the planning, management, and 
conservation of trees, forests and related vegetation to create or 
add value to the local community in an urban area. 

Kuchelmeister 
1998b 

Urban forestry is defined as the planning and managing of trees, 
forests and related vegetation to create or add values to the local 
community in an urban area 

Kuchelmeister 
1998c 

The establishment, management and utilisation of woody and 
other vegetation which integrates the qualities and experiences of 
the hedgerow and woodland countryside into the urban setting, 
which ameliorates pollution, extreme weather and glare and which 
contributes to the production of timber, food and opportunities for 
public recreation. 

Salter 1998 

Urban forestry is a specialization within forestry that 
encompasses the management of naturally occurring and planted 
trees in urban areas. 

Harris et al. 1999, 
2004 

Urban forestry can be defined as an integrated approach to the 
planting, care and management of trees in urban and peri-urban 
areas, to secure economic, environmental, and social benefits for 
urban dwellers. 

Gilliland 1999 

Urban forestry can best be described as the planting and 
management of all trees and woodlands in towns and cities.  It 
includes all trees and how they interact to form a unified resource 
– the urban forest.  The urban forest can be broken down into 
various categories, including: streets trees; trees in woodlands in 
public parks and open spaces; woodlands in private estates; trees 
in hedgerows; motorway plantings; and trees in private grounds, 
gardens, schools, golf courses, cemeteries, etc. 

Gormley 1999 

Urban forestry is the integrated biophysical management of urban 
forest ecosystems for improving the quality of life. This includes 
the art, science and technology of managing trees and forest 
resources as an integral part of urban community ecosystems for 
physiological, sociological, economic and aesthetic benefits 

SAF 2004 

Urban forestry involves the management of trees and associated 
resources in urban and urbanizing areas.  This management may 
be planned and undertaken at several scales, ranging from 
individual tree to the metropolitan landscape and beyond. 

Dwyer et al. 2002 

Management of publicly and privately owned trees in and 
adjacent to urban areas. 

Schuck et al. 2002 

The art, science, and technology of managing trees, forests, and NUCFAC 2003 
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natural systems in and around urban areas for the health and well 
being of communities 
The art, science, and technology of managing trees and forest 
resources in and around urban community ecosystems for the 
physiological, sociological, economic, and aesthetic benefits trees 
provide society. 

Burley et al. 2004 

Urban forestry, which is the management of publicly and 
privately owned trees in and adjacent to urban areas, has emerged 
as an important branch of forestry. Urban forests include many 
different environments such as city greenbelts; street and utility 
rights-of-way; forested watersheds of municipal reservoirs; and 
residential, commercial, and industrial property.

Encyclopedia 
Britannica Online 
2004 

Urban forestry is an integrated concept, defined as the art, 
science, and technology of managing trees and forest resources in 
and around community ecosystems for the psychological, 
sociological, aesthetic, economic, and environmental benefits 
trees provide society.  An urban forests defined as comprising all 
tree-dominated green areas in and around urban areas. 

Konijnendijk and 
Randrup 2004 

Broadly defined, UCF is the comprehensive management of trees, 
forests, and related natural resources in populated areas, such as 
inner cities, suburbs, the outer areas of cities and towns, and 
communities of various sizes. 

U.S. House of 
Representatives 
2004 

The cultivation and management of trees and forests for their 
present and potential contributions to the physiological, 
sociological and economic well-being of urban society. 

Government of 
British Columbia 
(undated) 
 
borealforest.org 
(undated) 
 

In the context of carbon offsets, tree planting undertaken in urban 
areas to provide shade and insulation to buildings and residences, 
reducing the energy required for heating and cooling. CO2 
emissions reductions are accomplished through sequestration in 
the trees and reduced energy demand. 

Canadian 
Agricultural 
Energy End-Use 
Data and Analysis 
Centre (undated)  
 

(1) The practice of forestry in an urbanized environment; (2) A 
specialized branch of forestry that has as its objective cultivating 
and managing trees in urban areas and the evaluating their 
contribution to the physiological, sociological, psychological 
(and sometimes economic) well-being of urban society. 

Lasting Forests 
(undated)  

Urban / Community Forestry is management of natural resources 
in urban and rural community environments. This includes the 
wildlife, aquatic resources, turf, flowers and shrubs and, of 
course, the trees. 

Western Illinois 
University 
(undated) 
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Proposed Definitions of the Urban Forest and Related Terms Source 
The urban forest is a flexible concept that encompasses rows of 
street trees and clusters of trees in city parks, green belts between 
cities and eventually forests that are more remote from the inner 
city.  The urban forest occupies that part of the urban ecosystem 
made up of vegetation and related natural resources found in 
urban, suburban, and adjacent lands, regardless of ownership.  As 
we move across the urban-rural gradient, the mix of benefits 
provided by the urban forest changes.  The limits of the urban 
forest cannot be defined by a line on a map.  More importantly, 
the urban forest provides a conceptual framework within which to 
organize a research program to maximize the benefits that forests 
can contribute to improving urban environments. 

Moeller 1977 

An urban forest, therefore, is that portion of the urban ecosystem 
that consists of forest vegetation, water, soil, and wildlife in 
densely populated areas and adjacent lands. 

Shafer and Moller 
1979 

We use the words “urban forests” to include all urban trees and 
related green spaces, whether those trees are growing singly or in 
groups. 

Driver and 
Rosenthal 1980 

The urban forest is defined here to include all outdoor vegetation 
within the legal boundary of a city, including herbaceous, shrub 
and tree canopy layers. 

Sanders and 
Rowntree 1984 

The urban forest can be most simply defined as the planted 
environment within the fabric of a variety of man-made uses.  
Collectively, it includes trees, shrubs, and lawns in city parks, 
public areas, private yards, and shopping centers – the overall 
green environment.  It is a people-oriented forest designed to 
provide a quality living environment and enhance the social, 
cultural, sensory, and economic dimensions of urban life.  The 
urban forest also has ecological value.  It modifies the 
environment in a positive way by providing shade, wind 
protection, air filtering, noise reduction, and soil protection.  It 
can modify the environment negatively when it requires more 
energy and water resources to maintain than are reasonably 
available in the long term.  The measure of urban forests value 
and viability would be in how well positive benefits are balanced 
with consumptive requirements. 

Hudson 1985 

Urban forest, broadly defined, constitute all vegetation in urban 
areas. 

Rowntree 1986 

The urban forest may be defined as the sum of all woody and 
associated vegetation in and around dense human settlements, 
ranging from small communities in rural settings to metropolitan 
regions. 

Miller 1988, 1997 

We use a broad definition of the urban forest that includes all 
vegetation within, or adjacent to, an urbanized area.  This 
includes suburbs and rural communities where vegetative 

Stevens and 
Rowntree 1989 
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management is influenced by the neighboring urban center.  
Trees, shrubs, and herbaceous cover are all considered 
components of the urban forest. 
Urban forests are not restricted to urban areas, they can be found 
wherever trees are subject to stress imposed by the proximity of 
large numbers of people. 

Cramb 1993 

An urban forest is the area in and around the places we live that 
has or can have trees.  Street trees, park trees, green spaces, 
residential land, public and private spaces with vegetation 
collectively make up the urban forest.  This includes the urban 
fringe where subdivisions are under construction as well as the 
rural land that is being considered for development. 

Moll 1995 

Urban forests are ecosystems characterized by the presence of 
trees and other vegetation in association with people and their 
developments.  Although people and developments influence 
forests across the country, urban forests are located where human 
influences are concentrated (cities, towns, and villages). 

Dwyer et al. 2000 

urban forest n. A dense, widespread growth of trees and other 
plants covering an area of a city. 
 

The American 
Heritage® 
Dictionary of the 
English Language, 
Fourth Edition 
2000

The urban forest includes all woody vegetation within the 
environs of all populated places.  In this sense, it includes not 
only trees within city limits, but also those on associated lands 
that contribute to the environment of populated places. 

Sudha and 
Ravindranath 2000 

For the purpose of this study, ‘urban forests’ and ‘urban trees’ 
were defined as forest stands and trees with amenity values 
situated in or near urban areas.

Andersen et al. 
2002 

We define the urban forest as the aggregate of all vegetation and 
green spaces within communities that provide benefits vital to 
enriching the quality of life.

Pee Dee Resource 
Conservation and 
Development 
Council 2002 

Urban forests refer to all forest and tree resources in (and close 
to) urban areas. 

Konijnendijk 2003 

Urban forest is defined as a forest situated within the area of a 
town, where social functions are stressed more than others. 
(Abstract translated into English by the authors. English language 
editing by Jana Oštir.) 

Osanič and Pirnat 
2003 

Urban forest is defined as woodland located in or near an urban 
area. 

Tyrväinen et al. 
2003 

The aggregate of all vegetation and green spaces within 
communities that provide benefits vital to enriching the quality of 
life  

Center for Urban 
Forest Research 
(undated) 
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Appendix – B 
Common tasks working with GIS 

 
All instructions given for working in ArcMap 
 
Adding Layers:
 
Pull down “File”>Add Data 
Specify where to import the data from (i.e. 
\\oasis\gis>Wisconsin>tiger>wi_urban_areas_2000.shp) 
Ensure that the new layer is in the correct projection 
 If not, Pull down “View”>Data Frame Properties 
 Click on the “Coordinate System” tab 

Click Predefined>Projected Coordinate Systems>State Systems>NAD 1983 
HARN Transverse Mercator 

 
 
Creating a Union:
 
Open the ‘Arc Toolbox’ 
Select ‘Analysis Tools’>Overlay>Union 
Within the Union window, select the ‘Input Features’ (the layers to combine) from the 
folder button on the right and click Add. 
Label the Output Feature Class 
Click OK 
 
 
Creating an Intersect:
 
Open the ‘Arc Toolbox’ 
Select ‘Analysis Tools’>Overlay>Intersect 
Within the Intersect window, select the ‘Input Features’ (the layers to find similar areas 
between) from the folder button on the right and click Add. 
Label the Output Feature Class 
Click OK 
 
 
Exporting Data Tables for Use Within Excel: 
 
Right click on the layer to export 
Select ‘Open Attribute Table’ 
Click on Options>Export 
Label the Output Table noting the title and location so it can be found later.  Keep the 
file in .dbf format. 
Open the exported data table in Excel.  Save as an Excel file to save manipulations 
and/or calculations. 
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Converting Downloaded Lat/Long Data into Representative Dots: 
 
Open the downloaded Excel data table 
Export as “Tab Delimited” out of Excel into a new data table 
 
In ArcMap select “Tools”>Add XY Data 
 Choose the data table that was just created and specify the X Field and Y Field 
 This will bring the data in as an Event 
 Export the data as a Shape file 
 
Next the new file needs to be projected 
From the “Arc Toolbox” select Data Management Tools>Projections and 
Transformations>Feature>Project 
 Select the input data table 
 Label the output file 
 Click the box to the right of “Output Coordinate System” 

Click “Select”>Projected Coordinate Systems>State Systems>NAD 
1983 HARN Transverse Mercator 

 
 
Adding an Area Field to a Table and Calculating your Area Value: 
 
Step #1: 
Make sure that editing is turned off: Click on Editor>Stop Editing (If not already off) 
Right click on the theme of interest and select “Open Attribute Table” 
When the table opens select Options>Add Field 
 
In the Add Field dialog box: 
 Enter the Name of the new field: i.e. Area 
 Change the type to: Double 
 Field Properties: 
  Precision: # of significant digits (16 were used) 
  Scale: # of decimal places you want (2 were used) 
  Click on OK 
Click on the new Area field header in the table 
Right click and Select “Calculate Values” (Click on YES if a message appears) 
 
Step #2: 
In the Field Calculator window: 
 Put a check mark in the “Advanced Box” 
 Click on Help 
 In the Help window, scroll down to where it says “To Calculate Area” 
 Highlight the four lines of code (see below) and copy to the clipboard 
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  Dim Output as double 
  Dim pArea as Iarea 
  Set pArea = [shape] 
  Output = pArea.area 
 
 Close the Help window 
  
 Click the cursor in the “Pre-Logic VBA Script Code” box 
 Paste the four lines of code into the box 
 In the bottom box (where it says Area =) type the text Output  

Click on OK, this will give a calculated area in square meters because the layer 
was in WTM.   
To convert into acres or hectares, the output is divided by 4,046.856 (acres) or 
10,000 (hectares). 
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